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1 Star Bill of Lading Software

Star Bill of Lading Software
 
Welcome to the Star Bill of Lading Program Help file.
Below you will find various links to the different areas of our Help file.  Explore them thoroughly to learn
how to process some of the different functions throughout this system.  If you are having problems, be
sure to investigate them here first before you contact our support staff.  This just gives you a faster
response to your questions.
 
When you run the program you will start out with the Main System Screen.  This will be the starting
point for all areas of the program.  There is a Menu system on the top of the screen that can be used to
navigate around every part of the program.  After reviewing this Help file, if you still cannot determine your
problems, by all means, send us an email with your situation and a detailed explanation to
support@starresoft.com  We will be glad to assist you.
 
Introduction
Typical Processing
Initial System Setup
Main BOL Screen and Options
Search for Bills
Database Maintenance
Printing Bill of Lading Form
Available Reports
Shipping Label Processing
Program Setup Screen
Change Shipper Screen
Custom Setup Options Screen
Importing/Exporting Data
Backing Up System files
System Purge options
System Requirements
Network Setup Information
Versions of Star BOL software available
Registration Information
Custom Modifications Available
File Layouts
Future Enhancements/Upgrades
EULA - End User License Agreement
Copyright Information
Current Versions Available and their differences
Version History
 
 
www.starresoft.com
www.starbol.com

http://www.starresoft.com
http://www.starbol.com
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2 Introduction

Introduction
 
The Star Bill of Lading program was written to create a simple way to create Standard Straight Bill of
Lading Forms.  These forms will be printed on a Standard Laser, Ink-Jet, or Dot Matrix printers.
It takes most of the work out of creating all your Bills of Lading.  
There are many features and options that allow you to customize the way this program is used and
make it more suitable for you own Company needs.  
 
Using this program will allow you or your firm to save time and money as it is very affordable and very
easy to use.  Save money on costly pre-printed forms.  If you wish, you can now create your BOL's to
be printed on either pre-printed multi-part forms, or blank multi-part forms using a dot-matrix printer.
 
This program creates a very professional looking, easy to read Bill of Lading form straight from your
laser/ink-jet printer.  This program comes with a high quality professional database system that will
handle all of your data storage needs.  It easily stores all your entered BOL's, along with all your
constant data, such as Consignee's, Carriers, Description of Articles, and many more types of default
information.  It will also handle all of your third party billing issues, along with Prepaid and Collect
shipments.  It has also been designed to process hazardous material shipments.  Most of the features
included in this system has been developed with the end-user in mind, as most of them have come from
requests of our users.  You can easily change the options to customize it more to your liking by using
the Setup Displayed Options fields area.  It can handle up to 6.7 Trillion records, which for all purposes,
should be able to handle your data requirements.  There are import/export capabilities, along with a data
backup feature to help control your data protection requirements.  Read through this help file, as most of
the features and functions are described within.  If you cannot find your answers here, then by all means
send us an e-mail at support@starresoft.com, our support staff will be happy to answer your questions
as needed.
 
BOL v10.xx should be able to handle all of your needs as is.  If there are other functions you would like
to add feel free to contact us via our Help Desk located at help.starre.com and we will review them and
offer a quotation on the costs associated with those changes, or we could even add such an option to a
future release.
 
We are always looking to upgrade and offer a more functional product.  Be sure to check for updates
often on our web site @ www.starbol.com  As a registered user, you are eligible to receive all

upgrades and updates to this program for a period of 1 year (365 days).  This is our policy for all of our
products.  You will be offered to continue this products support along with upgrades and updates for an
additional year at a very reduced price.  See the registration area for more information.

http://help.starre.com
http://www.starbol.com


Part

III



Star Bill of Lading 1112

© 2020 Starre Enterprises, Inc. (starresoft.com)

3 Typical Processing

Typical Processing
 
Basically, after initial setup, you are ready to create your first Bill of Lading.    
 
Be sure to have selected the shipper you are using on this BOL before you click on New.  This is only
needed if you have setup multiple shippers.  Otherwise, just click on the NEW button to create a new
BOL.
 
If you have setup the system to use Modifiable BOL's, then a pop-up screen will be displayed to enter
the BOL# for this record.  This must be a unique number to this system.
 
You will notice, that the BOL# has been assigned.  Also, today's date has been pre-loaded.  You can
change the date if you wish, or just press either the Tab key, or the Enter key to advance to the next
field which is the Carrier.
 
All you need to do is to start typing a Carrier name, and a drop down screen will allow you to select a
pre-entered  Carrier, or you can add new ones using the Add/Modify button.
 
Next, you can (if displayed) enter the PRO#, SCAC, Carrier#, Trailer#, or Seal# if needed.
 
The Consignee/Customer number is displayed next.  Here you can key in the Consignee/Customer ID,
and if it is already in your system, it will load the Consignee information in the following fields.
Or, you can press F2 to perform a look up.
 
You will then tab over to the Consigned to:  This is where you can enter a Consignee/Customer from
scratch, or you can either press F2, or click on the drop down box.  This will display the database of
your Consignees.  Here you can either select one, or if you need to add, then just click on the Add.
Modify.  If you do not want to use the drop down, or know that the Consignee does not exist in the
database, you can just key the information into the name and address area, when you are done, if it
does not exist, you will be prompted whether or not you want to add it into the database.
 
If your Consignee needs the material shipped to a different address, you can use the deliver to address
fields.  You can select pre-entered Deliver to addresses, that are assigned to the Consignee by either
pressing F2, or using the drop down box.  If you need to add one, you can either select the Add/Modify
button during the drop down process, or click on the Maintenance menu, then Consignees.  When the
Consignee maintenance screen appears, you only need to click on the Edit menu option, then Edit
Deliver to's.  Be sure to select the Consignee that you wish to add Deliver to's to.  All Deliver to
addresses, are assigned or related to each of the Consignees.  
 
There are contact fields that you can enter in that will also display on the BOL.  They are set up for
Names and Phone numbers.
 
Next, you can optionally enter information into the fields, Customer Order#, Our Order#, and Dept.
 
The Shipper Per field can be used to enter your name, or who is responsible for processing this
shipment. 
 
Prepaid/Collect/3rd Party/Canceled/Void/PrePaid/Add - This defines what type of payment is being
made for this shipment.  You can choose Prepaid, Collect, or 3rd Party.  If you choose 3rd party, then
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there will be a popup window to allow you to choose the 3rd Party billing party, or just key in a new one.
 
The next area is for COD payments.  It displays the Amount, a Fee if there is one, along with whether it
is a Prepaid COD or Collect.  If the COD is to be remitted to a different name and address, then you just
need to click on the Button, and a popup will be displayed for you to key one in.
 
If this is a Hazardous material shipment, then you could use the next couple of fields.  These are the U.
S. DOT Hazmat Reg. No and Placards.   If you need to put in the Hazmat number, you can enter it here.
 If you need to define the placards needed on this shipment, just click on the Pick Placards button, a
window will display that will allow you to select up to three placards to be displayed on the vehicle.
 
You can enter Special Instructions in the Special Instructions fields.  This can be pre-defined in the
Consignee record if you wish.  You can also setup the Special Instructions to contain default ones that
you use multiple times.  Here you would just press F2 to look up, or click on the eclipse to the right of
the field to perform a look up.
 
You can enter Route information in the Route field. This can be pre-defined in the Consignee record if
you wish.
 
If you want to enter a special message, then you would place it in the BOL message area.
 
When you get to the grid where the Detail Lines of the BOL are entered, you can add lines by simply
pressing the Tab or Enter key through the last field displayed and a new line will appear.  You can add
as many lines as you wish, as the grid will roll down as you add more lines.
 
When finished, just click the Print button to print out your BOL's to a Laser printer.  That is about it.  
 
To create another repeat the process.  You will find that there are many areas that allow for speed entry
by using drop down options.  The BOL data is saved to a Database for historical purposes or to Copy an
old one to create a new one.  
 
 
Back to Main Help
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4 Initial System Setup

Initial System Setup
 

The initial setup of this system is not very difficult, but it is very important to spend a little time to
understand everything that is required to properly setup the system for normal use.  Failure to set up
properly, can cause problems that can cause extra work to correct the problems.  Here are the basics to
correctly setting up the system.
 
After installation of the program, just run the BOL program.  
The first area you want to set up is the Shipper information.  This is done by selecting either the menu
option Setup, then click on System/Shipper Setup Properties, or by just pressing F4 (Function 4 key). 
This will display the Shipper setup/selection screen.  Here are the fields that are displayed on this
screen with a short description of their meanings and uses.  These need to be filled in with your pertinent
information.
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Shipper:
This is the name of the Shipper who is processing the shipments.
 
Address:
Shippers permanent address lines 1,2,3.
 
Phone/Fax
Phone number and Fax number of the Shipper.  These fields are optional.  They are printed on the BOL
on the bottom left hand corner of the form only if entered.
 
E-mail address
This is an optional field that will print on the bottom left hand corner of the BOL if entered.
 
Emer. Contact/24 Hour Number
This is the Emergency Contact Name.  Here you would put in the name or company that is responsible
if there is an emergency during the shipment.  This is mainly used for the transportation of Hazardous
material and is required for this type of shipment. If using the Canadian Option, it will display 24 Hour
Number for the heading as this is what is used for the Canadian bills.
 
Emergency #
Emergency Phone number.  This is where you enter the Emergency Phone number that is to be called
in case of an Emergency situation.  This is mainly used for the transportation of Hazardous material and
is required for this type of shipment.
 
Registered Company.
This is a default value for the Shipper, and will be loaded to all New BOL's if Entered.

Dft. Carrier.
This is a default value for Carrier.  If a value is entered here, then it will be used when creating new Bills.
This field also contains a lookup feature to load a Carrier that is already in the system.  You can access
this drop down selection by either clicking on the eclipse to the right of the field, or pressing the F2 key
while the cursor control is in the field.

Dft. Route.
This is a default value for Route.  If a value is entered here, then it will be used when creating new Bills. 
The name on this field can change if you updated the Field Settings section of the Setup Options
screen.  Then it will reflect those changes.  Otherwise the default is for the Route field.

Dft. Special Instructions.
This is a default value for Special Instructions.  If a value is entered here, then it will be used when
creating new Bills.  This field also contains a lookup feature to load a Special Instruction that is already
in the system.  You can access this drop down selection by either clicking on the eclipse to the right of
the field, or pressing the F2 key while the cursor control is in the field.  The name on this field can
change if you updated the Field Settings section of the Setup Options screen.  Then it will reflect those
changes.  Otherwise the default is for the Special Instructions field.
 
Dft. Message
If you enter a description here, it will print on every Bill of Lading.
 
Modifiable BOL#.
This check field is used to change the way the system handles the creation of the Bill of Lading
numbers.  If you check this field, then each Bill that is created, you will be prompted to enter a BOL
number.  Each one of these must be unique for each shipper in the system.  If you are using the system
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wide BOL number option then this number must be unique for the system.  If it is unchecked, then the
system will automatically create the BOL numbers for each shipper.  If you are using the system wide
BOL number option, then this number will be will be automatically created for the system sequentially.
 
Dft. Declared Value
This is the default declared value for the items being shipped. (ex. 2.00 - for $2.00 per)
 
Per
This is the default declared value per for the items being shipped (ex. LBS)
This is where you need to figure out a few things.  
 
Last BOL#
This field is used to display and keep track of the Bill of Lading numbers.  For system setup you can
enter any number to start with.  This number will change with each BOL created.  Do not change this
after initial setup unless necessary.
 
# of Copies
This is the default number of copies of the Bill of Lading that will print on each print command.  This can
be between 1 and 6.  
 
Label Printer & Type
The type of shipping labels and printer that is used to print them.  Here is a short description of the
different labels used in this program.
Laser Printer labels:
  Avery type 5168 labels:  4 to a page 
  Avery type 5163 labels:  10 to a page
  Avery type 5164 labels:  6 to a page 
  Avery type 5165 labels:  1 to a page - 11" x 8 1/2"
  Avery type 5526 labels:  2 to a page
  Bar Code Type Thermal Printer Labels:  6" x 4" labels
  Bar Code Type Thermal Printer Labels:  3" x 4" labels
 
For more information about processing the Shipping Labels see the Shipping Label Processing.
 
Dft. Prepaid/Coll.3rd
This is the system default that defines new BOL's as whether they are to be set up as Prepaid, Collect
of 3rd Party billing options.  This can be changed on each BOL, as this is only a default.  You can also
setup each Consignee/Customer with their own default setting which will override this setting when you
select the Consignee during entry of the BOL.
 
Printed Weight Description
This field is used to select the Printed Weight Description on the Bills.  You have an option of either
LBS, KG or Blank.
 
Default Bill to Address Button.  
This is an optional field that will allow you to enter a default Bill to Name and Address.  This will print on
each BOL if entered.  This is very useful if all of your bills are 3rd Party or if you require payment to be
sent to a different address.

Default Section 7 Signature Name.  
This is an optional field that if filled in will Auto Sign the Section 7 Signature section of the BOL with the
Name you enter into this field.
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Copy 1 Caption
This is the caption that is printed on the top of the Bill of Lading - this will print on Copy 1
 
Copy 2 Caption
This is the caption that is printed on the top of the Bill of Lading - this will print on Copy 2
 
Copy 3 Caption
This is the caption that is printed on the top of the Bill of Lading - this will print on Copy 3
 
Copy 4 Caption
This is the caption that is printed on the top of the Bill of Lading - this will print on Copy 4
 
Copy 5 Caption
This is the caption that is printed on the top of the Bill of Lading - this will print on Copy 5
 
Copy 6 Caption
This is the caption that is printed on the top of the Bill of Lading - this will print on Copy 6
 
Logo
This is the shipper logo that can be used if you desire one.  This will print on each BOL on the right side
of the BOL next to the Shipper information.  You can load a logo into the system by using your mouse. 
Just right click on the logo area, you will be displayed a menu.  To load a logo, just click on Load.  This
will prompt you to load a logo file.  You can use any Bitmap file and it will be saved into the system for
the selected shipper and will print on all BOL's for this shipper.  If you would like to delete a logo, just
follow the same selection, but select delete instead of load.  
 
Shipper #
Each Shipper that is entered into the system needs to be assigned a shipper number.  This is an alpha-
numeric field that can contain just about any code.  The system is setup and installed with 10 predefined
shipper records, they range from 01 - 10.  These do not need to be changed unless you feel it
necessary.  If you create a new record, you will have to key in a code for each one you create.  You will
be prompted if you forget to enter a code.
 
Default Shipper
If you click on the check mark, it will define the selected Shipper as the Default Shipper.  What this
means is the selected shipper will be loaded as the shipper each time you start the program.
 
Setup Options button.  This button should also be clicked on to setup other options when you first
install.  For more information about this just check out the Custom Options Setup Screen
 
Shipper Selection Grid
The grid that is displayed at the top of this screen can be used to select a specific Shipper by double-
clicking on the selected shipper.  You can also sort the Shipper records by clicking on the grid headers
to sort the records by either Name, Address, or Shipper number.
 
Basically, after initial setup, you can start loading your default files for use.  This would include your 
Consignee's/Customers, Carriers, Descriptions/Items, etc.
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5 Main BOL Screen and Options

Main BOL Screen and Options
 

All of the fields that are displayed on this screen are pretty much self explanatory but here is a recap on
what they are and the type of data you need to enter into each field.
 
BOL #:
This is a auto incrementing numeric number that will assign itself as you create a new Bill of Lading
Form.  It can also be changed to make it a modifiable user entered number.  Each shipper that you have
created in this program will control it's own Bill of Lading numbering.  Thus, if you have two different
shippers, you can have two separate BOL sequence numbers - See System Setup.  
 
You can also make this a number be controlled system wide.  To set up the system for this - See
system setup.
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To make the number User Modifiable - See System Setup.
 
Date:
Date of Bill of Lading/Shipment.  This can be entered in the format MM/DD/YYYY - or you can use the
drop down box to select the date using a calendar.
 
Carrier:
Shipping Company assigned to package/shipment. - This field has a look up option that you use to look
up into the Carrier file.  If you would like to add Carriers to the Carrier file, you can either select the drop
down box, then click on the Add/Modify button, which will take you to the Carrier maintenance screen. 
Or, you can click on the Maintenance Menu option, then click on Carriers.  This will display the Carrier
maintenance screen to allow you to add/delete/modify carriers in the system.  The original build came
with a number of carriers already built in, which you can delete if you wish.
 
PRO#:
This is the assigned number from the carrier that is used for tracking, etc.  (Can be non displayed - go to
Displayed Options)
 
SCAC:
This is the assigned SCAC code of the carrier. (Can be non displayed - go to Displayed Options)
 
Carrier#:
This is an assigned Carrier number. (Can be non displayed - go to Displayed Options)
 
Trailer #
This is the trailer number of the carrier. (Can be non displayed - go to Displayed Options)
 
Seal #:
This is a Seal number on the Trailer. (Can be non displayed - go to Displayed Options)
 
Consignee ID/No:
The Consignee/Customer number is the number or ID assigned to the Consignee/Customer.  Here you
can key in the Consignee/Customer ID, and if it is already in your system, it will load the Consignee
information in the following fields. Or, you can press F2 to perform a look up.
 
Consigned to:
Where the package/shipment is Consigned to:  This includes the address lines below it.  You can add
new Consignees by just keying them in.  If they are new and do not reside in the database, you will be
prompted whether you would like it to be added.  If you select yes, then you will be taken to the
Consignee maintenance screen for other fields to be added if you wish.
 
Deliver to:
This is used in the event that the shipment is to be delivered to a different address. This includes the
address lines below it.  You can also, add deliver to addresses, by selecting the Add/Modify button on
the drop down screen.

Return BOL:
If this option is displayed and checked, when you print the BOL it will reverse the Shipper and Consignee
fields on the printed BOL.  This is used to be sent to the actual Consignee who is now the Shipper for
content to be return to the original Shipper, which will be listed as the Consignee.
 
Customer Order#:
This is used to enter the Original Customer Order Number.
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Our Order#:
This is Our Order number for the shipment of goods.
 
Shipper Per:
This is the person creating this BOL.  You can save this information in the system setup as a default
and loaded on each new BOL created unless changed.
 
Prepaid/Collect/3rd Party:
Select which is to be used.  If 3rd party is selected, a pop-up window will be displayed to enter the #rd
Party Information.  You can also double-click on this to pop up the 3rd party billing selection screen. 
Here you can add/modify names of billing companies, or just select one of the pre-entered names to
load to the BOL.
 
COD Amount:
This is the amount to be collected for a COD shipment.
 
COD Fee:
This is a Fee that is associated with collecting a COD payment.
 
Prepaid/Collect COD.
This is to determine if the COD Fee is Prepaid, Collect, 3rd Party, Void, Canceled, or PrPaid/Add
 
Remit C.O.D. if Different Address:
This button is used to display a Name and Address of whom receives the COD payment.
 
Registered Company.:
This is the registered company number assigned to the Carrier from DOT.  (Can be non displayed - go to
Displayed Options)
 
Pick Placards:
This button is used to enter the required Placards that need to be placed on the Carrier's Vehicle.  Just
click on the button, a screen will be displayed that will allow you to select which placards are need.  you
can select up to 3 different placards to be printed on the BOL.  If you need to add/modify the placards
file, just click on the Edit menu displayed on the screen, or you can modify this off the main screen,
under Maintenance, Placards.  (Can be non displayed - go to Displayed Options)
 
Driver Supplied:
Whether the Driver supplies the Placards: (Can be non displayed - go to Displayed Options)
 
Section 7 Signature:
This field if used will print a signature in the Section 7 of the Bill: (Can be non displayed - go to
Displayed Options)
 
Freight Charges:
This field is used to enter the actual freight charges.  It does not print on the Bill, but prints on the
Shipping Report: (Can be non displayed - go to Displayed Options)
 
Special Instructions:
This is field that will allow you to place special instructions onto the BOL printout. This field is 100
characters long and allows for any data to be typed into it, or you can look up predefined records in the
Special Instructions Database, which will print on the BOL.  This can also be pre-selected and used as a
default that is assigned to the Consignee.
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Route:
This is a Route text field that allows you to enter Routing instructions to the Driver.  This field is 100
characters long and allows for any data to be typed into it, which will print on the BOL
 
BOL Message:
This area is used to add a message to the BOL printout form for this BOL only.  This field is 100
characters long and allows for any data to be typed into it, which will print on the BOL
 
Qty
Number of Packages being described.
 
UM
Unit of Measure - Packaging ie. PLT - Pallets, BOX - Boxes, etc.  to maintain the list, just select the
Maintenance menu option on the main screen, then Unit of Measure Codes.  (Can be non displayed - go
to Displayed Options)  If a UM of PLT is used, the piece count will not be accumulated in the totals.  If
you wish to include these in the totals, you must use a different UM such as SKID.
 
Qty2
Number of Packages being described. If displayed. 
 
UM2
Unit of Measure - Packaging ie. PLT - Pallets, BOX - Boxes, etc. To maintain the list, just select the
Maintenance menu option on the main screen, then Unit of Measure Codes.  (Can be non displayed - go
to Displayed Options)
 
HM/DG: 
Hazardous Material/Dangerous Goods(Canada) Check Box.  Shipment contains Hazardous Material/
Dangerous Goods(Canada).
 
Description of Articles, Items
Description of Articles, or Items being shipped.  This field is used for either item descriptions or
miscellaneous message to be printed on the BOL.

Unit Weight:
The unit weight of the Articles, Items.  If this is displayed then calculations for weight will be Qty * Unit
Weight to give you the Weight.  If not displayed, then there is only the calculations for weight if Item is
selected from drop down. This option to turn on/off is under the Displayed Options/Fields screen.
 
Weight:
The weight of the Articles, Items.

User11:
This is the user defined field to be entered.  There is also a database lookup selection if selected in the
setup.
 
Class:
Class of Item Shipment
 
NMFC
NMFC Code for shipments (Can be non displayed - go to Displayed Options)
 
NMFC SUB
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NMFC Sub Code for shipments (Can be non displayed - go to Displayed Options)

LOT Lot number of product. (Can be non displayed - go to Displayed Options)
 
You will also find options of the menu system.  Here are the definitions of those options
 
File
Import/Export - allows you to Import or Export data from the system.
Backup/Restore - allows you to backup or restore the data.  You can also use this option to run the
Data Purge feature.
Preview - This allows you to Preview a BOL before printing.
Email Bill - Will create a pdf of the current BOL and send it via email if this option is turned on.
Batch Processing - This allows you to select and print the BOL's that are scheduled to be Batch
Printed.
Print - You can also Print the BOL from here.
Exit - allows you to end the program.
 
Edit
You can create a new BOL from here
There is an Edit button on first run in the Network Edition only.
If you wish to copy an existing BOL to a New one, click on Copy/New.
You have the option to Delete a Record here.
Modify the BOL's Declared Shipping Values.
If this BOL is to be billed to a Third Party, you can click on the option here.  This will allow you to enter
the information onto the BOL.
Select Shipper - this will display the Shipper screen.
You can also, Changed the assigned Shipper.
Send to Batch Printing if the option is turned on.
Change/Reset BOL Status - this will change the BOL status back to Non-Printed.  You need to select
this if you already printed a BOL and need to edit it.
 
Search
Select this menu option to help you search for an old BOL by either the BOL Header or Header and
Detail records.
 
Maintenance
Select this menu option to display the different Database Maintenance options. 
Here are the different database maintenance files:
Carriers
Consignees/Customers
Descriptions/Items
3rd Party Billing
Item Classes
Unit of Measure Codes
Placards
Special Instructions
Shippers
Maintain Users
 
Reports
Print Shipping Labels.  This option allows you to print Shipping Labels on a printer using Avery 5168
style labels or on a Bar code type printer - Eltron, Zebra Etc.
Print Daily Manifest Report
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Print Consignee Manifest Report - Listing of Bill of Lading - by Consignee
Print BOL Report - Listing of Bill of Lading - History
Print Shipping Report
Print Shipping Report 2
Print Daily Carrier Manifest Report
Print Daily Shipping Log
Print Shipper Per Productivity
Product Shipment Report
Previews - You can preview each of the above reports without printing them.
 
Print Terms and Conditions Report - Listing of Bill of Lading Conditions and Terms.

Custom Reports - This is a Custom Report Writer where you can create your own reports.
 
Print Carrier Report - This prints a list of all the Carriers
Print Consignee Report - This prints a list of the Consignees
Print Deliver to's Report
Print Descriptions Report - Listing of all Items/Descriptions in system
Previews - You can preview each of the above file listings.
 
Print BLANK BOL - Prints a blank BOL form.
 
Setup
This is where you set up the initial information about your company.
Displayed Fields - This is where you can turn off/on certain fields in the program.
Email System Setup.
 
Help
Different information on how to obtain Help.
Web site addresses
Check for Updates - this will check for any updates that are available for this product.
About - Version number
 
There are also Buttons on the screen you may need information about.  Here it is.
 
There are also record Navigation system buttons.  Clicking on these will move you forward/backward
through the BOL records.  
 
Clicking on the New button will create a new BOL record.
 
To delete a record - You must click on the Edit menu option and click on Delete.
 
There is also a search button that will allow you to search the whole database using any of the displayed
fields.
 
The printer button allows you to print the BOL.

There is an Edit button on first run in the Network Edition only.
 
F2 - You can press this to perform a look up on the fields that have an eclipse to the right of the field.
 
F4 - Change the Shipper Information - If you use different shipping info, use this option.
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F6 - Load Bill.  This option will be available if you have the feature turned on.  It will allow you to load a
new bill of lading using the external import feature in the program.
 
F9 - Print Shipping Labels - This is a shortcut to print Shipping Labels - Prints 4 or less per page. or
single labels
 
F12 - Send Freight Bill to/3rd Party - This will popup the fields to enter the Name/Address of where the
bill should be sent to.

Ctrl-Del - will delete the selected line item for the BOL.

Ctrl-F - will display the Search BOL's screen.
 
Clicking on the Exit button will end the program.
 
Back to Main Help



Part

VI
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6 Database Maintenance

Database Maintenance
 
By selecting the Maintenance menu option off the main screen you can maintain the data files that store
default information such as Consignees, Items, Shippers, 3rd Party Billing Files, Etc.  Just click on the
menu option and select the file you wish to maintain.
 
Carriers
Consignee's/Customers
Deliver To's
Descriptions/Items
3rd party Billing
Item Classes
Unit of Measure Codes
Placards
Special instructions
Shippers
Maintain Users
User Defined Maintenance
 
To process a backup of the database, check out our Backup Section.
 
 
Back to Main Help



Part

VII
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7 Maintain Carrier file

Maintain Carrier file

 

This screen is used to display/maintain the Carrier file that is used in the program.  You have basic
Maintenance from this screen.  You can Add, Delete, Edit, etc., using the Navigation system displayed
at the bottom of the screen.  To add a record, click on the + (plus) sign.  To delete, just click on the -
(minus) sign.  It is all very simple and self explanatory.  The fields that are included in this screen are as
follows:
 
CARRIER'S NAME
This field is used to store the Carrier's Names.  This allows the ease of Entry when it comes to Entering
the BOL.
 
Address Fields:
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The address of your Carrier being used.
 
Phone 
Phone number of the carrier. 
 
Fax 
Fax number of the carrier. (Currently not used). 
 
SCAC
This is a default value for the Carrier, and will be loaded to the BOL if a value is entered.
 
Carrier#:
This is a default value for the Carrier, and will be loaded to the BOL if a value is entered.
 
Email 
Email address of carrier. (Currently not used). 
 
Web
Web site address of the carrier. (Currently not used). 
 
Use Pro # Range 
Select this check box if this Carrier has given you a range of Pro#'s to use.  This will tell the system to
create a Pro# based on the Last Pro# field with 1 being added to the Last Pro# to create the Pro#.  This
takes place if selected during the Print routine.  This will only happen on the first print, if you print
multiple times, it will not create a new Pro#. 
 
Last Pro #:
This is the tracking number used for the last Pro# generated for this Carrier.
 
Beg Range 
This is the beginning range tracker used in creating Pro#'s for this Carrier.
 
End Range
This is the Ending range tracker used in creating Pro#'s for this Carrier.

Use MOD7 Pro# Check Digit:
This option will add a MOD7 Check digit to the generated Pro# if using the Pro# generation feature.  This
will add the MOD7 check digit to the new Pro# when it is created during the print process and add the
new Pro# to the created bill.

Use YRC Pro# Check Digit:
This option will add the Check Digit processing for YRC which uses a specific check digit creation
process. This will add the YRC check digit to the new Pro# when it is created during the print process
and add the new Pro# to the created bill.

E Tracking Link Button:
By clicking on this option, you will be presented with the Email Tracking Link creation screen.  Here you
can define the Email Tracking link to be included with the emails that are sent to the Consignees.

Here is a screen shot of the Email Tracking Link Setup Screen.
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All of the following parts of the Tracking Link Creation is defined by the Carrier you are using. 
You should check with their I.T. Staff to determine their actual usage, and if they have this
capability via their website.

Tracking Link Part 1:
This field is used to define part one of the tracking link to the Carriers website.  If needed, there are
options for up to 5 different parts that will be combined to create the link call for the website of the
Carrier.  This will be combined with the PRO# to create the link.  For example, to create the proper link
to FedEx Freight, the Tracking Link would be -> http://www.fedex.com/Tracking?&tracknumber_list= 
This followed by the Pro#, will be used to generate the link.  This link if used, will be sent to the
Consignee via email if selected to do so.

Tracking Link Part 2:
This field is used to define part two of the tracking link to the Carriers website.  This is used in
combination with Part 1, Part 2, Part 3, Part 4, Part5, and the Pro# to create the Tracking link to the
Carriers website tracking page.

Tracking Link Part 3:

http://www.fedex.com/Tracking?&tracknumber_list=
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This field is used to define part three of the tracking link to the Carriers website.  This is used in
combination with Part 1, Part 2, Part 3, Part 4, Part5, and the Pro# to create the Tracking link to the
Carriers website tracking page.

Tracking Link Part 4:
This field is used to define part four of the tracking link to the Carriers website.  This is used in
combination with Part 1, Part 2, Part 3, Part 4, Part5, and the Pro# to create the Tracking link to the
Carriers website tracking page.

Tracking Link Part 5:
This field is used to define part five of the tracking link to the Carriers website.  This is used in
combination with Part 1, Part 2, Part 3, Part 4, Part5, and the Pro# to create the Tracking link to the
Carriers website tracking page.

Position Pro# After Part#:
This selection is used to define where in combination of the Tacking Link Parts where the Pro# is to be
placed to create the Tracking Link.

Strip[ Dashes from Pro#:
This selection is used to define whether or not to Strip any Dashes that reside in the Pro# before
creating the Tracking Link.  This would be defined by the Carrier.
 
Edit menu
Remove all records in Carrier file. - This option will remove all the current records that reside in the
Carrier file.  As you will notice, we have initially loaded the Carrier file with data.  If you prefer to clear the
file and add your own, this is a quick way to remove all the records that are loaded into the system. 
(This can only be performed if you are the only user logged into the system. - Network Version only)
 
Import/Export Data
There is also an option to Import/Export data to/from an outside file.  This option is off the menu and will
allow you to import/export data into/from this database file.
 
Just click on the option to import and follow the instructions.
 
See the Import/Export area for more information about this feature, along with the different file types that
are supported.
 
 
Back to Maintenance page
Back to Main Help



Part
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8 Maintain Consignment/Customer file

Maintain Consignment/Customer file
 

This screen is used to display/maintain the Consigned to/Customer file that is used in the program.  You
have basic Maintenance from this screen.  You can Add, Delete, Edit, etc., using the Navigation system
displayed at the bottom of the screen.  To add a record, click on the + (plus) sign.  To delete, just click
on the - (minus) sign.  It is all very simple and self explanatory.  The fields that are included in this
screen are as follows:
 
NAME:    
This field is used to store the Consigned to/Customers Name.
 
ADDRESS 1:
This field is used for the Consigned to's Address Line 1 information:
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ADDRESS 2:
This field is used for the Consigned to's Address Line 2 information:
 
ADDRESS 3:
This field is used for the Consigned to's Address Line 3 information:
 
CONSIGNEE ID:
This field is used as the Customer number, or ID.  You can set the system to search by this field on the 
Options Area.
 
CONTACT:
This is the Contact name for the Consignee/Customer.  If you wish to use and display this information on
the main entry screen and on the BOL form, just select this option in the Options Area.
 
PHONE:
This is the Contact Phone number for the Consignee/Customer.  This will only display if you are
displaying the Contact information in the system - See above.
 
DEFAULT SPECIAL INSTRUCTIONS:
This field is used to display the Special Instructions that are entered on the main screen.  The entry here
will be used on a new BOL if the particular Consignee is selected contains information here.  It has a
look up of the Special Instructions file that if pre-loaded, you can select ones already defined.  This will
override anything that is entered on the existing bill if a value exists.
 
DEFAULT ROUTE:
This field is used to display the Route Information that is entered on the main screen.  The entry here will
be used on a new BOL if the particular Consignee is selected contains information here.  This will
override anything that is entered on the existing bill if a value exists.
 
DEFAULT CARRIER
This is a default value for the Carrier that is used to ship to this Consignee.  The entry here will be used
on a new BOL if the particular Consignee is selected contains information here.  This will override
anything that is entered on the existing bill if a value exists.
 
PREPAID/COLLECT/3RD PARTY
This is a default value for the Consignee, and will be loaded to the BOL if Entered.  This will override
anything that is entered on the existing bill if a value exists.
 
DEFAULT EMAIL ADDRESS
This is a default value for the Consignee, and will be loaded to the BOL if Entered - this is used only if
you use the email function in this program.
 
DELIVER TO ADDRESS:
To add Deliver to addresses for the selected Consignee, just click on the Edit Menu option and select
Maintain Deliver To file.  This will assign the deliver to addresses to the selected Consignee.
 
Import/Export Data
There is also an option to Import/Export data to/from an outside file.  This option is off the menu and will
allow you to import/export data into/from this database file.
 
Just click on the option to import and follow the instructions.
 
See the Import/Export area for more information about this feature, along with the different file types that
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are supported.
 
Back to Maintenance area
Back to Main Help
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9 Maintain Deliver To's file

Maintain Deliver To's file

This screen is used to display/maintain the Consigned to/Customer Deliver To file if different that is used
in the program.  You have basic Maintenance from this screen.  You can Add, Delete, Edit, etc., using
the Navigation system displayed at the bottom of the screen.  To add a record, click on the + (plus)
sign.  To delete, just click on the - (minus) sign.  It is all very simple and self explanatory.  The fields
that are included in this screen are as follows:
 
NAME:    
This field is used to store the Deliver to/Customers Name.
 
ADDRESS 1:
This field is used for the Deliver to's Address Line 1 information:
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ADDRESS 2:
This field is used for the Deliver to's Address Line 2 information:
 
ADDRESS 3:
This field is used for the Deliver to's Address Line 3 information:
  
CONTACT:
This is the Contact name for the Deliver/Customer.  If you wish to use and display this information on the
main entry screen and on the BOL form, just select this option in the Options Area.
 
PHONE:
This is the Contact Phone number for the Deliver/Customer.  This will only display if you are displaying
the Deliver To Contact information in the system - See above.
 
Import/Export Data
There is also an option to Import/Export data to/from an outside file.  This option is off the menu and will
allow you to import/export data into/from this database file.
 
Just click on the option to import and follow the instructions.
 
See the Import/Export area for more information about this feature, along with the different file types that
are supported.
 
Back to Maintenance area
Back to Main Help



Part
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10 Maintain Descriptions/Items file

Maintain Descriptions/Items file
 

This screen is used to display/maintain the Descriptions/Items file that is used in the program.  You
have basic Maintenance from this screen.  You can Add, Delete, Edit, etc., using the Navigation system
displayed at the bottom of the screen.  To add a record, click on the + (plus) sign.  To delete, just click
on the - (minus) sign.  It is all very simple and self explanatory.  The fields that are included in this
screen are as follows:
 
DESCRIPTION:
This field is used to store frequently used Descriptions, Items, etc., for the detail line items of the Bill of
Lading.
 
DESCRIPTION 2:
This field is used to if a second description line is needed.
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PRODUCT ID:
This field is used only for look up purposes during the entry of a Line item of the BOL.  It does not print
on the Bill, but is useful if you wish to search the Descriptions/Item file by ID instead of Description/Item
name.  You can set the system to search by this field on the Options Area.
 
DEFAULTS:
The following defaults can be entered and will load as defaults when entering line items.
 
UM - Unit of Measure
UM2 - Unit of Measure
WEIGHT - Item weight or per unit
CLASS - Class
NMFC - National Motor Freight Classification
SUB - National Motor Freight Classification Sub number
HM - Determines if this is Hazardous Material or not.  Checked means it is.
 
 
Import/Export Data
There is also an option to Import/Export data to/from an outside file.  This option is off the menu and will
allow you to import/export data into/from this database file.
 
Just click on the option to import and follow the instructions.
 
See the Import/Export area for more information about this feature, along with the different file types that
are supported.
.
Back to Maintenance area
Back to Main Help
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11 Maintain Third Party Billing file

Maintain Third Party Billing file
 

This screen is used to display/maintain the 3rd Party Billing file that is used in the program.  You have
basic Maintenance from this screen.  You can Add, Delete, Edit, etc., using the Navigation system
displayed at the bottom of the screen.  To add a record, click on the + (plus) sign.  To delete, just click
on the - (minus) sign.  It is all very simple and self explanatory.  The fields that are included in this
screen are as follows:
 
NAME/ADDRESS:
This field is used to store frequently used 3rd Party Billing Names and Addresses.
 
Import/Export Data
There is also an option to Import data from an outside file.  This option is off the menu and will allow you
to import data into this database file.
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Just click on the option to import and follow the instructions.
 
See the Import/Export area for more information about this feature, along with the different file types that
are supported.
 
Back to Maintenance area
Back to Main Help
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12 Maintain Item Class file

Maintain Item Class file
 

This screen is used to display/maintain the Item Class file that is used in the program.  You have basic
Maintenance from this screen.  You can Add, Delete, Edit, etc., using the Navigation system displayed
at the bottom of the screen.  To add a record, click on the + (plus) sign.  To delete, just click on the -
(minus) sign.  It is all very simple and self explanatory.  The fields that are included in this screen are as
follows:
 
CLASS CODE:
This field is used to store frequently used Class Codes.
 
Back to Maintenance area
Back to Main Help
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13 Maintain the Unit of Measure Codes file

Maintain the Unit of Measure Codes file
 

This screen is used to display/maintain the Unit of Measure file that is used in the program.  You have
basic Maintenance from this screen.  You can Add, Delete, Edit, etc., using the Navigation system
displayed at the bottom of the screen.  To add a record, click on the + (plus) sign.  To delete, just click
on the - (minus) sign.  It is all very simple and self explanatory.  The fields that are included in this
screen are as follows:
 
Unit of Measure Codes:
This field is used to store frequently used Unit of Measure Codes.
 
Back to Maintenance area
Back to Main Help



Part
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14 Maintain Placards file

Maintain Placards file
 

This screen is used to display/maintain the Placards file that is used in the program.  You have basic
Maintenance from this screen.  You can Add, Delete, Edit, etc., using the Navigation system displayed
at the bottom of the screen.  To add a record, click on the + (plus) sign.  To delete, just click on the -
(minus) sign.  It is all very simple and self explanatory.  The fields that are included in this screen are as
follows:
 
Placard Description:
This field is used to store Placard Descriptions that will be selected and displayed on the BOL.
 
UN Code:
This UN Code that is associated with the Placard.
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Back to Maintenance area
Back to Main Help
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15 Maintain Special Instruction Codes File

Maintain Special Instruction Codes File
 

This screen is used to display/maintain the Special Instructions Codes file that is used in the program. 
You have basic Maintenance from this screen.  You can Add, Delete, Edit, etc., using the Navigation
system displayed at the bottom of the screen.  To add a record, click on the + (plus) sign.  To delete,
just click on the - (minus) sign.  It is all very simple and self explanatory.  The fields that are included in
this screen are as follows:
 
SPECIAL INSTRUCTION CODE:
This field is used to store frequently used Special Instruction Codes.  This code is only used for look up
function as it is not printed anywhere.
 
SPECIAL INSTRUCTION DESCRIPTION:
This field is used to store associated Special Instructions.  These descriptions are what is printed on the
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BOL's if selected.
 
Back to Maintenance area
Back to Main Help
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16 Maintain Shippers

Maintain Shippers
 
For information referring to this please look at the Initial System Setup.
 
 
Back to Main Help
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17 Maintain Users

Maintain Users
 

This screen is used to display/maintain the Users file that is used in the program.  You have basic
Maintenance from this screen.  You can Add, Delete, Edit, etc., using the Navigation system displayed
at the bottom of the screen.  To add a record, click on the + (plus) sign.  To delete, just click on the -
(minus) sign.  It is all very simple and self explanatory.  The fields that are included in this screen are as
follows:
 
User Name:
This field is used to store Name of the Users with access to this program.  This is a case sensitive field.
 
Password:
This field is used to store the Password associated with the User above.  This is a case sensitive field.
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Level of Access:
This field is used to store the Level of Access for the associated User above.  There are three options.
Administrator - Full access to all areas of the program.
User - Full access to non-secure areas of the program.  Cannot access setup and administrative
features. 
Limited - Limited access to areas of the program.  Cannot access setup, administrative, and file
maintenance features.  Can create and print BOL's.
View - Very limited access.  Can only view records and print reports.
 
Initial setup adds one user - ADMIN, with a password of ADMIN.  Please change this if using this
feature.
 
Back to Maintenance area
Back to Main Help
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18 User Defined Maintenance

You can set up this system to use 9 User Defined fields that already exists in the system to display and
print something different if needed.
The fields you can use are as follows:
Customer Order Number
Our Order Number
Shipper Per
Carrier#
Trailer#
Seal#
Dept
Registered Company
Route

If you rename the fields, and activate the lookup database, you will be able to create a database list of
commonly used records.  To activate this option, you need to go to the Setup menu, then Displayed/
Options fields, then select the Field Settings as shown below.
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Here you can rename the fields that are displayed and printed on the BOL, and there is a check mark to
activate the database lookup for that field.
When you activate the lookup check mark, it will display eclipses on the associated fields on the main
BOL screen for you to click on to perform a lookup.

If they are not activated, then you will not see the eclipse for the lookup on the main screen, and you will
not see the menu option under the Maintenance menu to update the file.
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18.1 Maintain User01 File

Maintain Customer Order Lookup/User01 file
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This screen is used to display/maintain the Customer Order/User01 file that is used in the program.  You
have basic Maintenance from this screen.  You can Add, Delete, Edit, etc., using the Navigation system
displayed at the bottom of the screen.  To add a record, click on the + (plus) sign.  To delete, just click
on the - (minus) sign.  It is all very simple and self explanatory.  The fields that are included in this
screen are as follows:
 
CUSTOMER ORDER #:
This field is used to store frequently used Customer Order Numbers, or if using this as a Custom Named
field, it will store those items to be used in the lookup option on the main BOL screen.
 
Back to Maintenance area
Back to Main Help

18.2 Maintain User02 File

Maintain Our Order Number/User02 file
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This screen is used to display/maintain the Our Order Number/User01 file that is used in the program. 
You have basic Maintenance from this screen.  You can Add, Delete, Edit, etc., using the Navigation
system displayed at the bottom of the screen.  To add a record, click on the + (plus) sign.  To delete,
just click on the - (minus) sign.  It is all very simple and self explanatory.  The fields that are included in
this screen are as follows:
 
OUR ORDER#:
This field is used to store frequently used Our Order Numbers, or if using this as a Custom Named field,
it will store those items to be used in the lookup option on the main BOL screen.
 
Back to Maintenance area
Back to Main Help

18.3 Maintain User03 File

Maintain Shipper Per/User03 file
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This screen is used to display/maintain the Shipper Per/User03 file that is used in the program.  You
have basic Maintenance from this screen.  You can Add, Delete, Edit, etc., using the Navigation system
displayed at the bottom of the screen.  To add a record, click on the + (plus) sign.  To delete, just click
on the - (minus) sign.  It is all very simple and self explanatory.  The fields that are included in this
screen are as follows:
 
SHIPPER PER:
This field is used to store frequently used Shipper Pers, or if using this as a Custom Named field, it will
store those items to be used in the lookup option on the main BOL screen.
 
Back to Maintenance area
Back to Main Help

18.4 Maintain User04 File

Maintain Carrier#/User03 file
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This screen is used to display/maintain the Carrier#/User04 file that is used in the program.  You have
basic Maintenance from this screen.  You can Add, Delete, Edit, etc., using the Navigation system
displayed at the bottom of the screen.  To add a record, click on the + (plus) sign.  To delete, just click
on the - (minus) sign.  It is all very simple and self explanatory.  The fields that are included in this
screen are as follows:
 
CARRIER#:
This field is used to store frequently used Carrier#, or if using this as a Custom Named field, it will store
those items to be used in the lookup option on the main BOL screen.
 
Back to Maintenance area
Back to Main Help

18.5 Maintain User05 File

Maintain Trailer#/User05 file
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This screen is used to display/maintain the Trailer Numbers/User03 file that is used in the program.  You
have basic Maintenance from this screen.  You can Add, Delete, Edit, etc., using the Navigation system
displayed at the bottom of the screen.  To add a record, click on the + (plus) sign.  To delete, just click
on the - (minus) sign.  It is all very simple and self explanatory.  The fields that are included in this
screen are as follows:
 
TRAILER#:
This field is used to store frequently used Trailer Numbers, or if using this as a Custom Named field, it
will store those items to be used in the lookup option on the main BOL screen.
 
Back to Maintenance area
Back to Main Help

18.6 Maintain User06 File

Maintain Seal#/User06 file
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This screen is used to display/maintain the Seal#/User03 file that is used in the program.  You have
basic Maintenance from this screen.  You can Add, Delete, Edit, etc., using the Navigation system
displayed at the bottom of the screen.  To add a record, click on the + (plus) sign.  To delete, just click
on the - (minus) sign.  It is all very simple and self explanatory.  The fields that are included in this
screen are as follows:
 
SEAL#:
This field is used to store frequently used Seal#, or if using this as a Custom Named field, it will store
those items to be used in the lookup option on the main BOL screen.
 
Back to Maintenance area
Back to Main Help

18.7 Maintain User07 File

Maintain Dept/User07 file
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This screen is used to display/maintain the Dept/User03 file that is used in the program.  You have basic
Maintenance from this screen.  You can Add, Delete, Edit, etc., using the Navigation system displayed
at the bottom of the screen.  To add a record, click on the + (plus) sign.  To delete, just click on the -
(minus) sign.  It is all very simple and self explanatory.  The fields that are included in this screen are as
follows:
 
DEPT:
This field is used to store frequently used Dept, or if using this as a Custom Named field, it will store
those items to be used in the lookup option on the main BOL screen.
 
Back to Maintenance area
Back to Main Help

18.8 Maintain User08 File

Maintain Registered Company/User08 file
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This screen is used to display/maintain the Registered Company/User08 file that is used in the program.
 You have basic Maintenance from this screen.  You can Add, Delete, Edit, etc., using the Navigation
system displayed at the bottom of the screen.  To add a record, click on the + (plus) sign.  To delete,
just click on the - (minus) sign.  It is all very simple and self explanatory.  The fields that are included in
this screen are as follows:
 
REGISTERED COMPANY:
This field is used to store frequently used Registered Companies, or if using this as a Custom Named
field, it will store those items to be used in the lookup option on the main BOL screen.
 
Back to Maintenance area
Back to Main Help

18.9 Maintain User09 File

Maintain Route/User09 file
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This screen is used to display/maintain the Route/User09 file that is used in the program.  You have
basic Maintenance from this screen.  You can Add, Delete, Edit, etc., using the Navigation system
displayed at the bottom of the screen.  To add a record, click on the + (plus) sign.  To delete, just click
on the - (minus) sign.  It is all very simple and self explanatory.  The fields that are included in this
screen are as follows:
 
ROUTE:
This field is used to store frequently used Route, or if using this as a Custom Named field, it will store
those items to be used in the lookup option on the main BOL screen.
 
Back to Maintenance area
Back to Main Help

18.10 Maintain User11 File

Maintain Route/User11 file
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This screen is used to display/maintain the Route/User09 file that is used in the program.  You have
basic Maintenance from this screen.  You can Add, Delete, Edit, etc., using the Navigation system
displayed at the bottom of the screen.  To add a record, click on the + (plus) sign.  To delete, just click
on the - (minus) sign.  It is all very simple and self explanatory.  The fields that are included in this
screen are as follows:
 
User 11 Field:
This field is used to store frequently used Custom Named field, it will store those items to be used in the
lookup option on the main BOL screen.
 
Back to Maintenance area
Back to Main Help
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19 Database Lookup Screens

In the program itself, you will find fields that are filled out during the normal entry of a bill that contain an
eclipse on the right hand side of the entry field.  This allows if clicked on or if you press the F2 key, a
lookup screen to appear that will allow you to search and select a pre-entered value from the lookup
database for the selected field.  Here is a list of the screens that are used to lookup items.  When one of
the following screens are displayed, you can key in a value into the filter bar field and it will display the
matching records.  You can also use a wildcard character - * to search say ABC* and it will display all
the records in the field that starts with ABC or you can use *ABC* and it will display all the records that
contain the characters ABC anywhere in the field.  You can tab through any of the fields in the filter bar
to narrow your search.  To select a record, you can click on the Select button or just dbl-click on the
record value you would like to carry over the the previous field.  There is also an option button called
Maintenance which will call the Maintenance screen so you can add more entries into that selected
table. 
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20 Database Lookup Filtering and Selection Process

When you perform a database lookup to fill a selected field on the screen, there is a filter bar at the top
of the screen that is used to filter down the displayed values of the presented grid below. Using this filter
bar can speed up the process and help you find what you are looking for if the underlying database has a
large number of records. Below are screen shots of how to use the filter bar to reduce the displayed
values.

To perform a search/lookup for a field, it must first contain an eclipse to the right of the field.  This is the
little box that contains 3 dots in it.  These are the only fields that are available to perform a lookup on.  If
your screen does not have all the ones that are displayed below, you can turn on the options under the
Displayed/Options Fields screen.  This is accessible from the main screen under the Edit menu.

To activate a search/lookup you can click on the eclipse box or the easier way is to press the F2 key
when you are in the actual field to be looked up.

When the lookup is activated, you will be displayed the lookup screen with the available values to load
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into the field you are in. The cursor or focus is placed in the associated calling field as displayed below.
You can start keying in a value to lookup or filter. 

As you key in a value, the number of records in the displayed grid is reduced based on the value you
key in. When you see the value you want to select, you can quickly press the down arrow key to
highlight it, then press Enter to select it.  If there is only one record displayed, then just press Enter to
select it.  Or, you can use your mouse to dbl-click on the record to select it.  Whichever way works best
for you.
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During the filter process, you can use wildcards to find values that are within the column fields.  What
this means is if you are looking for a Consignee and you cannot remember exactly what the name is,
but you know it has the value of FARM somewhere in the name, you can use the wildcard (*) which is an
asterisk and key it into the filter bar field, then follow it with the value of FARM.  This will filter all the
records and display any of them that contain the word/characters FARM.  Then you can select based on
the records shown.



Star Bill of Lading 1192

© 2020 Starre Enterprises, Inc. (starresoft.com)

You can also use multiple wildcards if there are multiple filter fields/columns available. Just key in
multiple wildcards as displayed below.
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To quickly reset and clear out the filter entries because you entered the incorrect filter values, press the
ESC (Escape Key) and it will clear out what you have already keyed in.  Or, of course you can use the
menu option Edit, then Clear Filter.  Obviously just pressing the ESC key is a bit quicker.  
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After you have selected the value to be loaded to the original field, the lookup screen will disappear and
the value will be loaded.
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There are multiple lookup fields throughout the application that you can perform searches to make
keying in values much faster.  They all will contain the aforementioned eclipse box to  the right of the
field. Below is a markup of the available fields on the main screen.  If your screen does not match
exactly the number of available fields, that is because you do not have all the database lookup files
activated.  These can be found under the Setup Menu, Displayed/Options Fields, and then the Field
Settings.  There you can turn on the Database lookups for the different available fields.
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Here is where you can turn these lookup fields on or off by placing a check mark in the appropriate row.
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21 Bill of Lading Form Printing

Bill of Lading Form Printing
 
There are now 3 different types of BOL printouts you can select from.  They are as follows:
 
Laser/Ink Jet type. (Default)
Dot Matrix Printer on multi-part blank forms.
Dot Matrix Printer on Pre-Printed multi-part forms.
 
To setup the system to print to the different types of printers and forms, go to the Systems Options
Page.
 
Depending on the number of copies you select, it changes the number at the bottom of the page, along
with the headings on the top of the page.
 
To print a Bill of Lading, all you need to do is to click on the print button, or if you wish, you can click on
the menu, File, then Print.  This will take you to a screen that will ask you how many copies, or Number
of BOL sheets needed.  The default is the number that was set up on the shipper setup screen.  You
would either change this number, or just click on Print.  This will cause the program to print the Bill of
Lading to the selected printer.
 
You can also send a PDF file via email.  You would just click on the Email button if it is displayed.  If it
is not displayed, then you can have it displayed bu changing the System Options.
 
If you would like to print the Bill of Lading to an Adobe PDF file for either archiving or to send via email,
you can select the Print 2 PDF button if it is displayed.  If it is not displayed, then you can have it
displayed by changing the System Options.
 
 
If you would like to print a Blind Shipment Bill of Lading, just process a print as described above.  When
you reach the Select the Number of BOL Sheets Needed screen, you need to click on the Menu option,
File, then Select a Blind Shipment Bill of Lading to print.  This will cause the bill to print, but will not list
any Shipper information.
 
Back to Main Help
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22 Search Bill of Ladings

Search Bill of Lading
 

You can sort, search, filter, group, and find just about any of the pertinent information contained in your
Bills.  

This screen is used to run a search on a particular BOL.  You can either scroll through the Bills using
the Navigation buttons on the bottom of the screen, or you can select the Search button.  The search
button will display a grid area that will allow you to search by BOL#, Consigned to, or Date.  This makes
it a little easier to find a particular BOL.  If you select one, and press the OK button, the selected BOL
will be displayed on the main BOL screen.  This screen will only show BOL's that have been assigned to
the selected shipper.
 
There is now a feature that will allow you to group the records by the heading fields.  Just drag the
header to the top box and all the records will be grouped by this selection.  You can sort by any of the
fields that are displayed.

There is also a feature called the filter line, where you can key in exactly what you are looking for and it
will filter out the records that contain that information.  You can also assign and filter using wildcards
such as *90909* and it will filter out all the records that contain the specified selection in the selected
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field.
 
You can double-click on a record and it will be loaded to the main screen.
 
 
Back to Main Help
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23 Search Bill of Lading Detail records

Search Bill of Lading Detail records
 
You can sort, search, filter, group, and find just about any of the pertinent information contained in your
Bills.  Then just dbl-click to load to the main screen.

There is a feature that will allow you to group the records by the heading fields.  Just drag the header to
the top box and all the records will be grouped by this selection.  You can sort/group by any of the fields
that are displayed.  If you wish to sort, you can just click on the Header field and it will either sort
ascending or descending order. As seen below.

There is also a feature called the filter line, where you can key in exactly what you are looking for and it
will filter out the records that contain that information.  You can also assign and filter using wildcards
such as *90909* and it will filter out all the records that contain the specified selection in the selected
field. This is shown below.
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As you can clearly see, there are many different ways to display and search for information that resides
in the files.

There is a View menu option that will allow you to show or not show many different options/fields so you
can actually see what you are looking for.
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Then of course, just double-click on a record and it will be loaded to the main screen.
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24 Reports

Reports
 
There are reports that you can run from this program.  They are accessible from the Main Page, off the
menu that states - Reports.  The available reports from this menu are:
 
Print Shipping Labels
Daily Manifest
Consignee Manifest
BOL Report
Shipping Report
Daily Carrier Manifest
Daily Shipping Report
Shipper Per Productivity Report
Lot Shipment Report
Product Shipment Report
Custom Reports
BOL Terms and Conditions
Carrier Listing
Consignee's/Carriers listing by Name
Consignee's/Carriers listing by Cons ID
Descriptions/Items listing by Desc.
Descriptions/Items listing by Prod Id.
Print a Blank BOL
Batch Printing of BOL's
Print a Blind Shipment Bill of Lading
 
You can now print the reports or if you would like, you can now print them to an Excel spreadsheet for
further processing.
 
Back to Main Help
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25 Daily Manifest Report

Daily Manifest Report
 

The Daily Manifest report will display what was shipped today.  Or, for a period of time.  You will be
prompted for a data range before it is printed.
 
Back to Reports Area
Back to Main Help
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26 Daily Carrier Manifest

Daily Carrier Manifest
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The Daily Carrier Manifest report will display what was shipped today by Carrier.  Or, for a period of time.
 You will be prompted for a data range and Carrier before it is printed.
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Back to Reports Area
Back to Main Help
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27 Consignee Manifest Report

Consignee Manifest Report
 

The Consignee Manifest report will display what was shipped today by Consignee.  Or, for a period of
time.  You will be prompted for a data range before it is printed.
 
Back to Reports Area
Back to Main Help
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28 Shipping Reports

Shipping Report

Shipping Report 1 

Shipping Report 2 - has a bit different layout of information as displayed.

The Shipping reports will display what was shipped today.  Or, for a period of time.  You will be prompted
for a data range before it is printed.  This only prints on Legal Paper as the width of the report is too wide
for letter paper.
 
Back to Reports Area
Back to Main Help
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29 BOL Report

BOL Report
 

The BOL report will print information about today's Bills.  Or, for a period of time.  You will be prompted
for a data range before it is printed.
 
Back to Reports Area
Back to Main Help
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30 Daily Shipping Log

Daily Shipping Log
 

The BOL report will print Today's Shipping Log.  
 
Back to Reports Area
Back to Main Help
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31 Shipper Per Productivity Report

Shipper Per Productivity Report
 

The Shipper Per Productivity Report will print information about the Shipper Per's Productivity.
 
Back to Reports Area
Back to Main Help
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32 Lot Shipment Report

Lot Shipment Report
 

The Lot Shipment Report will print information about the Lots that have been shipped.  This will only be
displayed as an option of you have the Lot# usage selection set up in the System Settings.  This will
give you a listing of all the shipments(BOL's) created using the selected Lot# that is entered as a
selection.
 
Back to Reports Area
Back to Main Help
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33 Product Shipment Report

Product Shipment Report
 

The Product Shipment Report will allow you to print a report that contains what was shipped to a
selected Consignee or all Consignees.  There is a date selection along with a Product ID, or Product
Description selection, along with a Consignee selection.
 
Back to Reports Area
Back to Main Help
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34 Terms and Conditions

Terms and Conditions
 
The Terms and Conditions report will print the Terms and Conditions that are normally found on the
backside of the Bill of Lading.  This is the legal information pertaining to the BOL.  You can
automatically print this out after each Bill by changing the option in the System Options Screen, or you
can print it from the Reports menu.
 
Back to Reports Area
Back to Main Help
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35 Custom Reports

Custom Reports
 
This section will explain how to use the Custom Reports section of the program. 
This section is available as an add in to the program.  It is available via our web site at: http://www.
starbol.com 

To access this section in the program, you just need to select the Reports menu from the main screen,
then select the menu options Custom Reports.  Of course this menu option will only be displayed and
accessible if you have purchased and installed the Custom Reports Module.

This will display the following screen.

There are multiple options you can select from this screen to start with.  

The menu options at the top of the screen can be used and contain the following commands.
File Menu:
Open
New
Design
Print
Print Preview
Delete
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Rename
Close
These options are used to create a new Folder, or Report and proceed from there.
You can also use the right click option on your mouse to bring up these options on the screen.

To start, just click on the File menu, then click on the New option, then select Folder.  This will allow
you to create a new folder in the system to store your custom reports in.  You can name it anything you
wish, just use something that makes sense to you.
Then select that folder and click on the File menu again or right click, whichever you prefer and select
New Report.
This will bring up the Report Designer as displayed.

There are three tabs on the top of the screen.  Data, Design, and Preview.

You begin by selecting the Data tab.  This is where you would select the data that is to be used in the
report.  You just click on the tab for Data.  You will be displayed a blank screen unless you already
created the data specs.  Here you would just click on the File menu, then New.  This will display the
New Items.  Just click on the Query Wizard then click on OK, to begin the data selection process.
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After selecting the Query Wizard, you will be displayed this screen to select the table to be used..

Here is a list of the available tables to be used..
BOLD - Bill of Lading Detail file.
BOLH - Bill of Lading Header file.
CARR - Carrier file
CLAS - Classifications file
CONS - Consignee file
CTRL - Control/Shipper file.
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DELT - Deliver to file
DESC - Descriptions/Items file

All the other files listed are really not available for reporting, but are in the database and should not mean
anything to the end user.

To select a file, just dbl-click on it or highlight it and click on the > arrow button to load into the selected
tables section.
For example, select the CONS file.

Then click on the Next button.

There are other options to allow for customizing things, but you can just continue until you get to the
Order screen.  This will allow you to select the order the file will be presented or sorted.  Just click on
the Set Order and select a field such as the Consignee Name and click Continue.
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You will then be displayed the finished screen.  Just click the Finish button.

You will be brought back to the Designer screen.
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You have now selected a table to be used in creating the report. 
From here just click on the Design Tab and you will be displayed the report designer.

You have different areas that you can perform functions with. 
Report Tree - This shows the different sections of the report
Report Bands - This shows the different bands in creating the report layout.
Selection Properties - This shows the available properties for the selected item.
Available Table Fields - These are the available table fields to place on the report.
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You can select a table field and place or drag right from the Available Table fields.  When you select a
field and drag it to the Detail band, it will automatically select the field to be printed along with a header
or text field to describe it.  You can change the header field or just delete it if not needed by selecting it
and pressing the delete key.  To change it just change the text in the text selection field as shown.

After adding fields and whatever you wish to change, you can click on the Preview button to see the
results of the report.
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If all is well, then just click on the File menu on the Design Tab and select Save.  This will prompt you for
a name to save the report as.

After you save it, just close the Design screen and it will be displayed on the Report Explorer screen.

You have created your first report.  
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You can select the report again and either print it, preview, go back again and edit it, delete it, etc.

You can create as many reports as you wish and organize them in the Report Explorer. 

Here is a list of the file layouts used with this software.

For more details, on usage, just contact our help desk located at http://help.starre.com
 

http://help.starre.com
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36 Shipping Label Processing

Shipping Label Processing
 
This area is used to describe the process for printing Shipping Labels.  This system has been setup so
that you can automatically print 4 different types of shipping labels.  You can either print them to a Laser
printer or to a Bar code type printer.  
 
The included shipping labels are as follows:
Laser Printer labels:
  Avery type 5168 labels:  4 to a page 
  Avery type 5163 labels:  10 to a page
  Avery type 5164 labels:  6 to a page 
  Avery type 5165 labels:  1 to a page - 11" x 8 1/2"
  Avery type 5526 labels:  2 to a page
 
Bar Code Type Printer Labels:
  6" x 4" labels
  3" x 4" labels
 
Custom Labels:
  Print 10 to a page.
  3x5 Dot Matrix Feed Style
 
To select which type of labels you wish to print to, just click on the Setup Menu option on the main
screen, then click on System/Shipper Setup Properties.  or you can just press the F4 (Function 4) key.
 
From this screen, just click on the Label Printer & Type field, there is a drop down box to the right, just
click on the box.  This is a drop down field which will display each of the different Label types as
described above.
 
To actually print the labels, all you need to do is after you have completed the Bill of Lading entry, you
can either press the F9 (Function 9) key, or click on the Reports Menu option, then click on Print
Shipping Labels.  You will be prompted to enter the number of labels you wish to print.  This number that
you select is the actual number of labels that will be printed, not the number of sheets.  If you are using
the Avery type 5168 labels, then you will be able to print 4 per page.  If you select 5 labels, then it will
need 2 sheets to print the 5 labels.  If you select 1, then it will print 1 label on the top left portion of the
label page.  If you only use one label, then on your next label print you can re-use the same sheet for
the other 3, just load the label form in upside down, so it can have access to the other 3 labels.  We are
working on adding the function that will allow you to select which label to print to, but it has not been
completed as of yet.
 
 
 
Back to Main Help
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37 Carriers Listing

Carriers Listing
 
The Carriers Listing will print out all the information that resides in the Carriers file. 
 
Back to Reports Area
Back to Main Help
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38 Consignee's/Customers Listing by Name

Consignee's/Customers Listing by Name
 
The Consignee's/Customers Listing by Name will print out all the information that resides in the
Consignee file by Name. 
 
Back to Reports Area
Back to Main Help



Part
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39 Consignee's/Customers Listing by Cons ID

Consignee's/Customers Listing by Cons ID
 
The Consignee's/Customers Listing by Cons ID will print out all the information that resides in the
Consignee file by Cons ID. 
 
Back to Reports Area
Back to Main Help



Part
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40 Descriptions/Items Listing by Desc

Descriptions/Items Listing by Desc
 
The Descriptions/Items Listing by Desc will print out all the information that resides in the Description/
Items file by Desc. 
 
Back to Reports Area
Back to Main Help



Part
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41 Descriptions/Items Listing by Prod Id.

Descriptions/Items Listing by Prod Id.
 
The Descriptions/Items Listing by Prod Id. will print out all the information that resides in the Description/
Items file by Prod Id. 
 
Back to Reports Area
Back to Main Help
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42 Print a Blank BOL

Print a Blank BOL
 
If you would like to print a blank Bill of Lading that contains no information on it other than your Shipper
information on it, just select this option from the Reports Menu.
 
Back to Reports Area
Back to Main Help



Part
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43 Print a Blind Shipment Bill of Lading

Print a Blind Shipment Bill of Lading
 
If you would like to print a Blind Shipment Bill of Lading, just process a print as described in the normal 
BOL print.  When you reach the Select the Number of BOL Sheets Needed screen, you need to click on
the Menu option, File, then Select a Blind Shipment Bill of Lading to print.  This will cause the bill to
print, but will not list any Shipper information.
 
Back to Reports Area
Back to Main Help



Part
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44 Batch Printing of BOL's

Batch Printing of BOL's
 
Bill of Ladings can be batch printed if you choose to do so.  There are two different ways to schedule the
BOL's to be batch printed.  After creating a bill, you have an option button displayed at the bottom of the
screen that will allow you to schedule the displayed bill to be batch printed.  This will mark the bill as
Batched.  After processing all bills for batch printing, you can print the bills.  To print the actual bills that
are marked as Batched, click on the Main menu, File, then Batch Processing, Print Batched BOL's. 
This will take you to the normal Print screen to select the number of copies.  Just click on Batch Print. 
This will cause the system to print all the bills that were marked for Batch Printing.
 
If you do not want to mark each BOL as you enter them, you can select them after you are done via the
Batch Selection Screen.  To get to this screen, just click on the Main menu, File, then Batch
Processing, BOL Batch Selections.  This will display a screen showing all the bills that have not been
printed yet.  You can select all or select individual bills listed for batch printing.  After selecting the bills
by clicking on the Check Box next to the displayed bill, you can close the screen and they are marked
for batch printing.  Then follow the instructions to print the batch.
 
 
Back to Main Help



Part
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45 Program Setup Screen

Program Setup Screen/Shipper Maintenance
 

This is used to enter your Company information.  Make sure you enter all the information on this page. 
Otherwise your BOL Forms will not print correctly.
 
The fields that are included in this screen are as follows:
 
Shipper:
This is the name of the Shipper who is processing the shipments.
 
Address:
Shippers permanent address lines 1,2,3.
 
Phone/Fax
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Phone number and Fax number of the Shipper.  These fields are optional.  They are printed on the BOL
on the bottom left hand corner of the form only if entered.
 
E-mail address
This is an optional field that will print on the bottom left hand corner of the BOL if entered.
 
Dft Shipper Per
This is an optional field that will load into the BOL if entered.
 
Emer. Contact/24 Hour Number
This is the Emergency Contact Name.  Here you would put in the name or company that is responsible
if there is an emergency during the shipment.  This is mainly used for the transportation of Hazardous
material and is required for this type of shipment.  If using the Canadian Option, it will display 24 Hour
Number for the heading as this is what is used for the Canadian bills.
 
Emergency #
Emergency Phone number.  This is where you enter the Emergency Phone number that is to be called
in case of an Emergency situation.  This is mainly used for the transportation of Hazardous material and
is required for this type of shipment.
 
DOT Haz Reg No.
This is a default value for the Shipper, and will be loaded to all New BOL's if Entered.
 
Dft. Message
If you enter a description here, it will print on every Bill of Lading.
 
Modifiable BOL#.
This check field is used to change the way the system handles the creation of the Bill of Lading
numbers.  If you check this field, then each Bill that is created, you will be prompted to enter a BOL
number.  Each one of these must be unique for each shipper in the system.  If you are using the system
wide BOL number option then this number must be unique for the system.  If it is unchecked, then the
system will automatically create the BOL numbers for each shipper.  If you are using the system wide
BOL number option, then this number will be will be automatically created for the system sequentially.
 
Dft. Declared Value
This is the default declared value for the items being shipped. (ex. 2.00 - for $2.00 per)
 
Per
This is the default declared value per for the items being shipped (ex. LBS)
This is where you need to figure out a few things.  
 
Last BOL#
This field is used to display and keep track of the Bill of Lading numbers.  For system setup you can
enter any number to start with.  This number will change with each BOL created.  Do not change this
after initial setup unless necessary.
 
# of Copies
This is the default number of copies of the Bill of Lading that will print on each print command.  This can
be between 1 and 6.  
 
Label Printer & Type
The type of shipping labels and printer that is used to print them.  Here is a short description of the
different labels used in this program.
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Laser Printer labels:
  Avery type 5168 labels:  4 to a page 
  Avery type 5164 labels:  6 to a page 
  Avery type 5165 labels:  10 to a page
  Avery type 5165 labels:  1 to a page - 11" x 8 1/2"
  Avery type 5526 labels:  2 to a page
 
Bar Code Type Printer Labels:
  6" x 4" labels
For more information about processing the Shipping Labels see the Shipping Label Processing.
 
Dft. Prepaid/Coll.3rd
This is the system default that defines new BOL's as whether they are to be set up as Prepaid, Collect
of 3rd Party billing options.  This can be changed on each BOL, as this is only a default.  You can also
setup each Consignee/Customer with their own default setting which will override this setting when you
select the Consignee during entry of the BOL.

Printed Weight Description
This field is used to select the Printed Weight Description on the Bills.  You have an option of either
LBS, KG or Blank.
 
Default Bill to Address Button.  
This is an optional field that will allow you to enter a default Bill to Name and Address.  This will print on
each BOL if entered.  This is very useful if all of your bills are 3rd Party or if you require payment to be
sent to a different address.

Default Section 7 Signature Name.  
This is an optional field that if filled in will Auto Sign the Section 7 Signature section of the BOL with the
Name you enter into this field.
 
Copy 1 Caption
This is the caption that is printed on the top of the Bill of Lading - this will print on Copy 1
 
Copy 2 Caption
This is the caption that is printed on the top of the Bill of Lading - this will print on Copy 2
 
Copy 3 Caption
This is the caption that is printed on the top of the Bill of Lading - this will print on Copy 3
 
Copy 4 Caption
This is the caption that is printed on the top of the Bill of Lading - this will print on Copy 4
 
Copy 5 Caption
This is the caption that is printed on the top of the Bill of Lading - this will print on Copy 5
 
Copy 6 Caption
This is the caption that is printed on the top of the Bill of Lading - this will print on Copy 6
 
Printed Weight Desc
This is the caption that is printed on the Bill of Lading that will describe the Weights Descriptions - It can
be LBS, KG or blank.
 
Default Bill-To Address Button
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This button when pressed will display a screen that will allow you to enter a default Bill-To address that
will be loaded onto each bill during creation.  This can be used if all your bills are to be sent to a third
party processor or a different address than the shipper.
 
Logo
This is the shipper logo that can be used if you desire one.  This will print on each BOL on the right side
of the BOL next to the Shipper information.  You can load a logo into the system by using your mouse. 
Just right click on the logo area, you will be displayed a menu.  To load a logo, just click on Load.  This
will prompt you to load a logo file.  You can use any Bitmap file and it will be saved into the system for
the selected shipper and will print on all BOL's for this shipper.  If you would like to delete a logo, just
follow the same selection, but select delete instead of load.  
 
Shipper #
Each Shipper that is entered into the system needs to be assigned a shipper number.  This is an alpha-
numeric field that can contain just about any code.  The system is setup and installed with 10 predefined
shipper records, they range from 01 - 10.  These do not need to be changed unless you feel it
necessary.  If you create a new record, you will have to key in a code for each one you create.  You will
be prompted if you forget to enter a code.
 
Default Shipper
This check mark field is used to select the Default Shipper you want to display when entering the BOL
system.  You have to make sure that if you use this field, that no other Shippers already have it
selected.  Just click on it to select and be sure to check the other shippers in the system so they do not
have it checked also.
 
Setup Options button.  This button should also be clicked on to setup other options when you first
install.  For more information about this just check out the Custom Options Setup Screen
 
 
Back to Main Help



Part

XLVI



Change/Select Shipper Screen 165

© 2020 Starre Enterprises, Inc. (starresoft.com)

46 Change/Select Shipper Screen

Change/Select Shipper Screen
 
This screen is the same as the Program Setup and is used to select a different shipper (you) and create
BOL for that shipper.  
 
To select a different shipper that has been loaded into the system, simply just Double Click on it, as the
screen will close and the selected shipper will be loaded.
 
If you have multiple shippers that need to be in the system.  Just select an open record in the grid above
and fill in the detailed data for that shipper.  If, you have more than the 10 default ones, just click on
the + sign in the navigator to create more.  But you will have to be sure to add a Shipper Number to the
record, or it will not allow you to continue.
 
Each time you select a different shipper, the corresponding screens will only display the records for that
shipper.
 
Also, after you exit the system the default shipper will be re-selected for your workstation.
 
You can also select the shippers from the Main Screen.  Just click on the Shipper Name field on the top
right hand corder of the screen.  This will drop down a box listing all of you defined shippers.  Just click
on one of them and you can start shipping using that shipper.

Here is a copy of the screen shots of the Shipper Screen.  The first one is the normal default layout.
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Here is a copy of the Shipper screen with the Filter Bar selected.  This allows you to select out or Filter
your Shippers by keying in a Filter into one or more of the Filter fields. To activate this option, select the
Edit menu, then Turn On/Off Filter Row on Grid.  This makes it much easier to select the Shipper if you
have many Shippers in the system.  You can also use a Wildcard of * to select out partial names, like
*tarr* in the Shipper name to select Starre, or just Star* will perform the same filter.  To remove the
filtering entries at anytime just press the Esc key to remove all filters or there is a menu option under the
Edit menu called Clear Filter.
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Here is a copy of the Shipper screen with the Grid Expanded (F4). Pressing the F4 key or selecting the
menu option under the Edit menu - Expand/Shrink Grid Display will expand or Shrink the list of Shippers
that you can see on the Grid.  This again is used for easier selection if you have multiple Shippers in the
system.
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Back to Main Help
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47 Custom Options Setup Screen

Custom Options Setup
 
There are 4 display tabs on this screen for different settings in the program.  They are: Display Settings,
Field Settings, System Settings, and Mandatory Fields.  Below you will find information about each of
these different tabs.

Display Settings:

This screen allows you to remove or display certain fields on the main screen.  Helpful if you never use
these fields.  You can also change the number that prints as the BOL#.  This is useful if you do not want
to use the system generated number as you BOL#.  All of these options can be changed, which will
allow for a more customized version of the software.  They also will not be displayed on the BOL
printout.
 



Custom Options Setup Screen 171

© 2020 Starre Enterprises, Inc. (starresoft.com)

Here is a list of the optional fields that can be displayed or turned off.
 
PRO#
SCAC Code
Carrier Number
Trailer Number
Seal Number
COD Information
US DOT Reg Number
Placards Required
Enable Section 7 Signature Entry
Freight Charges
UM - Detail Unit of Measure
Use 2 Unit of Measure and Quantity fields
NMFC Codes
LOT #'s
Total Quantity - Detail (for HazMat) - Also a custom field if you choose.
Detail Charges
Consignee/Deliver to Contacts/Phones

Display Print Return BOL Option - If you wish to be able to create Return BOL's that you would send to
your Consignee to be used as a Return BOL turn this option on.  It will display a Return BOL option on
the main screen to allow you to print the entered BOL as a Return BOL.  This will reverse the printing of
the Shipper and Consignee fields on the printed BOL to be used as a Return BOL for the Consignee to
ship materials back to the original shipper.
 
Display Email BOL Button - If you do not wish to email a bol file, then un-check this option and the
button will not be displayed during the printing process. 
 
Display Print 2 PDF Button - If you do not wish to print to a PDF file, then un-check this option and the
button will not be displayed during the printing process. You can still print to PDF by selecting the menu
option during a print.  
 
Auto Capitalize Desc/Items - This allows you to turn on or off the Capitalization of the Description of
Articles/Items descriptions.
 
Auto Print Terms and Conditions - This will automatically print the Terms and Conditions report after
each BOL is printed.
 
Print Detail Line Separator with each BOL - This will print a line in between each detail line items.  This
can be turned on or off.
 
BOLD QTY Detail field on BOL Printout. - This will turn the BOLD characteristic for the Detail QTY field
on during printing of the bills.
 
BOLD QTY Total field on BOL Printout. - This will turn the BOLD characteristic for the Total QTY field on
during printing of the bills.
 
BOLD WEIGHT Detail field on BOL Printout. - This will turn the BOLD characteristic for the Detail
WEIGHT field on during printing of the bills.
 
BOLD WEIGHT Total field on BOL Printout. - This will turn the BOLD characteristic for the Total
WEIGHT field on during printing of the bills.
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Display Skid Counts on 5165 Labels - This will allow the printing of Skid counts when printing to the
5165 labels.
 
Use Product ID on Search instead of Description - This option will allow you to search by Product ID
instead of Description during the search function while entering the detail line items of the BOL.  This
should only be checked if you are using the Product ID field in the Description/Items file.
 
Use Consignee ID on Search instead of Cons Name.  This option will allow you to search by Consignee
ID instead of the Consignee's Name during the search function while entering a BOL.  This should only
be checked if you are using the Consignee ID in the Consignee file.
 
Reverse the standard printing of Consignee and Deliver to addresses on BOL form. - This option will
reverse the printing locations for the Consignee and Deliver to address on the form.  This had caused an
issue with a few Carriers as they were sending bills to the wrong recipient.
 
Display Carrier Name on Shipping labels - On certain shipping labels, it will display the Carrier's name
on the label.
 
Display Piece Counts on Shipping labels  - On certain shipping labels, it will display the label piece
counts. (ie - 1 of 4) ect.
 
Display Skid Counts on 5165 Shipping labels - On certain shipping labels, it will display the Skid Counts
on the label.
 
Print PRO# on Labels - On certain shipping labels, it will print the PRO# on the label.

Print PRO# Bar Code on Labels - On certain shipping labels, it will print the PRO# in bar code format on
the label.  This also prints the human readable text with the bar code.  This option supersedes the Print
PRO# on Labels selection as it replaces this with the bar code.

Print From Address on Shipping Labels. - on certain labels you can remove or display the From
Address.  Mainly used is you have custom printed labels.

If using 4x6 or 4x3 thermal printer labels you can auto batch print them based on if you batch print the
BOL's.  There is a selection to choose how many labels will print for each BOL, either number of detail
lines or number of the total quantity of pieces on the BOL.

Do NOT Print any Order Numbers on Shipping Labels - If selected, no order numbers will be printed on
the shipping labels.

Print SCAC and BOL# Bar Codes on Bill - This will print the barcodes on the Bill for the SCAC and
BOL#'s, but will remove the logo if you are using one.

Print Carrier Number Bar Codes on Bill. - Selecting this option will add a bar code to the printed bill that
represents the Carrier number. This will print at the top of the bill above the Carrier number.
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Field Settings:
 
Custom Fields Names/Printed Form labels - This area is used to customize some of the fields used in
this program.  You can change the way each of these fields are named and displayed on the screens
along with the printed BOL.  This saves many modifications that were requested, so we passed the
process to the user.  You can reset them back to the defaults by clicking on the Edit menu, the click on
the Reset feature.
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System Settings:
 
Special System Wide Settings.
Use Pre-Printed Forms - Dot-Matrix - This feature will change the printout of the Bill of Lading to format it
to a pre-printed 3+ part form.  This form is available by contacting Starre Enterprises at the number on
our web site - www.starbol.com

Use Letter Size paper.  If this option is checked, then the program will use Letter Sized paper (8 1/2" x
11").  If this is unchecked, then it will use Legal Sized paper (8 1/2" x 14).
 
Use Blank Forms - Dot-Matrix - This feature will allow you to print your BOL's to a Dot-Matrix printer on
Blank Form Paper.  Basically the printout is identical to our Laser printout, except there is no shaded
boxes to be printed.  

Also, you can change the printed BOL# on the form to display either the BOL#,  Our Order Number,
Customer Order number, or the Carrier number.  If you do use the Carrier # option, be sure to allow for
this field to be displayed.  Default is BOL#. 

http://www.starbol.com
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Create BOL# using System Wide# - This feature will change the way BOL numbers are created. 
Normally, they are created by each shipper.  This makes all the BOL's to created to use one set of
numbers and not by shipper.

Print BOL# on the form - Default is Yes, if you select No, then the BOL# will not print on the printed bill.
This would only be set to No if you are using pre-printed BOL forms. 
 
Disable BOL Delete function - if this is checked then you will not be able to Delete any Bills in the
system.

Allow User Level Status to Reset Printed BOL Status - If this is checked, then a User level login can
Reset a Printed BOL status to allow for changing a bill that is already printed. 
 
Disable the Printed BOL lock - if this is checked they the Printed BOL lock will be removed.
 
Use Product ID's in Bill Entry and Printing.  This feature will allow you to key in the  Product ID's on the
bills and it will also print on the Bills.
 
Use Consignee ID on Search instead of Cons Name.
 
Reverse the standard printing of Consignee and Deliver to addresses on the BOL form.
 
Use MAPI email instead of BOL system default. - selecting this option will call your default email
system to send the BOL's.  This is used on systems that cannot use our default email system because
of restrictions placed by the ISP.  This way you can send the BOL's via your email system such as
Outlook Express and use your email address book.

Use Outlook Mail - Selecting this option will tell the system to insert a prefix of "smtp:" in front of the
email address when calling the email program.  This is used in the case that Outlook 2010 or other
versions need this to resolve the email names.  Only used if you are running Outlook Mail program and
the emails are not actually being sent.  This is an issue only with Outlook 2010 that we know of.

Use SSL Auth to send emails - Selecting this option will cause the program to use SSL Authentication
with your ISP/Email provider like Office365 and Gmail.  This is only used when using the internal email
system and not calling out to your own email client.

Loop twice on Email Command.  This option is used in the instance that the MAPI email is not called
correctly as on some systems, this is needed to properly run the email call.

Use Outlook 365 Mail Client.  This option will allow you to send the emails out using Outlook 365 client.
It will send email directly to the Outlook send box and will actually send the email during the Outlook
send process.  Must have the MAPI selection selected to enable this option. Also, if using Outlook 365
64bit client, you must register the 64 bit Com server selection under the Help menu.
 
Allow Sales Order file import and selection/load. - selecting this option will allow you to import a sales
file into the system that contains sales information such as the Customer info, ect.  This will be
accessible using either the F6 key or the menu option - Edit, Load Sales Order.  This option is currently
under development, but is active if you want to use it to access and load Customer information when
creating a BOL.  For more information about this option, you can contact our Web Support Help Desk.
 
Unlock Link between Deliver To's and Consignees.

Display Deliver To, if Different fields.  This option is used to turn on/off the Deliver to fields on the main
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screen.  If you never use these fields, you can turn them off here.

Add Quoted Amt and Handling Charges to program.  This option will display on the main BOL screen
two fields for Quoted Amounts and Handling Charges.  These fields do not print on the BOL, they are
there for internal usage only.

Do NOT include "PLT" UM in Total Pcs column.  This option if checked will not include any items that
have a UM of PLT in the total pieces column on the bill.  If unchecked, it will.  This is used for the
purpose of not including Pallets in the total pieces calculations.

Canadian Dangerous Goods Usage - selecting this option will change the defaults from Hazardous
Materials to Dangerous Goods.

Use Consignor's Certification SOR/2014-152 Sec. 3.61. - Selecting this option will print the Consignor's
Certification statement on the bill instead of the Shipper Certification statement.

Print Standard Anti-Diversion Clause - Selecting this option will print the Standard Anti-Diversion Clause
on the printed BOL.  This will not print if using pre-printed forms.
 
Use Password Security for Users. - selecting this option will all you to setup a Users file to define 3
levels of security to access the program.  This will cause the program to display a log in when the
program is run.  The three levels of security are Administrator, User, and View only.  More information
can be found in the Maintain Users file.

Turn On/Office Bubble Hints - This is used to turn on/off the Bubble Hints when you move your mouse
over selected areas that will display hints to their usage.

Use System Inactivity Shutdown - This option will shut down the software application after 3 hours of
inactivity.

Automatically Check for Software Updates - This option when checked will check for updates when you
run the software.  If unchecked, you can manually check for updates under the Help menu on the main
screen.

Use Backup feature on Exit. This option when selected will prompt you to run a backup when you exit
the software.  This is only available in the Single User Edition.

Automatically Backup on Exit. This option when selected along with the Use Backup feature on Exit, will
automatically run the backup without prompting you to do so. It will prompt you once for the location of
the backups and will create a backup using the format of bolfiles(todays date).zip  This way you will have
a backup of any of the days that the software was run with any changes or additions for that day.  If you
run the software multiple times per day, it will backup over the top of what was previously backed up that
day.
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Mandatory Fields:

This area is used to define which fields on the main BOL screen are mandatory.  This just means that a
value needs to be entered into the fields.  It does not edit check to see that a correct value is entered,
just a value.  It cannot be left blank if the associated field is checked as mandatory.
 
All changes will take effect after exiting the program and restarting.
 
Back to Main Help
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48 FAQ - Frequently Asked Questions

FAQ - Frequently Asked Questions
 
This is a listing of our Frequently Asked Questions.  This list is updated to date on our web site at www.
starbol.com
 
Q.  I cannot add a second line to the Bill of Lading detail lines.  How can I do this?
A.  All you need to do is to press the tab key through the rest of the detail fields until you reach the end
of the line, the program will automatically add a second line. etc.  You can perform this task by just
pressing the down arrow key too.  Also, if you want to add a blank line, you must enter a character into
the description line, such as just pressing the space bar, then tab through the rest of the fields as
described above.
 
Q.  How do I save my Consignee's into the database?
A.  Click on the Edit Menu on top of the screen, then choose Edit Consignee, or you can just key the
Consignee into the fields and you will be prompted whether or not you wish to add it to the database, if it
does not already exist.
 
Q.  Where do I add Deliver to Names and Addresses?
A.  You must click on the Edit Menu, then choose Edit Consignee, select a  Consignee, then click on
the Edit Menu, and then Edit Deliver to.  This is because the Deliver to is linked to the Consignee.
 
Q.  How do I edit the Carrier File?
A.  Click on the Edit Menu on top of the screen, then choose Edit Carriers.  You can add, maintain, or
delete records here.
 
Q.  What type of Shipping Labels are supported?
A.  We currently support 8 different types of labels.  They are Avery 5168 Style(4 to a page),  Avery 5163
Style(10 to a page),  Avery 5164 Style(6 to a page), Avery 5165 Style(1 to a page),  Avery 5526 Style(2
to a page), 3"x5" Dot Matrix fed, and a Bar Code Type printer style(6" x 4") and (4"x3").
 
Q.  There seems to be a Font problem on the Top Description line?
A.  Your computer does not have the Arial Narrow Font installed.  You can download that font here -
Click Me.  
Or, if you are not an advanced Windows user, you can download the BOL Font Installation Program,
when you run this program, it will automatically install the fonts for you. Just click on the underlined
program description above, or Just Click on Me. 
 
Q.  I would like to upgrade from the Single User Edition to the Network Edition.  Can I keep the
data that was created in the Single User Edition and transfer  it to the Network Edition?  If so,
what files would I copy?
A.  Yes, all you need to do is to copy the following files into the \data folder that  is being used for the
Network Version.  These files reside in the root directory where the Single User Edition was originally
installed.    
 
Q.  I would like to backup the data that is used in this program.  Is there a way to do this? 
A.  Yes, all you need to do is to select the option from the main menu.  Just click on File, then Backup/
Restore, then click on Backup/Save Data Files to Archives.  This will close the program and allow you to
save all the data to either a folder, diskette, or to another data source.  
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Q.  There are certain modification that we would like to have done to this program to better
suit our Company's needs.  Is this available?  And at what cost.
A.  Yes, modifications are available.  There is a minimum cost of $150 to create a custom version of the
software to fit your needs.  Depending on the extent of the modifications, obviously the price goes up
from there.  This is our hourly rate.  If you would like an estimate on modifications, just Contact us using
our web email system, or call us to discuss the changes further.  There is no cost for the estimate.
 
Q.  I am confused on the licensing of this program, are there any fees, or additional costs?  
A.  No, there are no additional costs to use this program as it is.  When you purchase the software, you
are entitled to 1 full year of Support and Updates/Upgrades from the original date of purchase.  This
includes all upgrades and updates to the software and the ability to call or email us for support.  After
the initial year is up, you will be sent an Order/Invoice for continued support and upgrades for an
additional year.  This is completely optional, and you are not required to pay the invoice.  You will pay
this only if you wish to continue the support and upgrades/updates for this package.  If you decide not to
pay, you will not be invoiced again.  You will also not be eligible for support or updates/upgrades.  If you
decide you would like an update or upgrade at a later time, you will have to purchase the program at it's
full price.  The current costs for the continued support and upgrades is $69.95 for the single user edition
and $139.95 for the network edition.
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49 System Requirements

System Requirements
 
Microsoft Windows XP/Vista/W7/W8/W10 operating system.
Minimum 40 MB of free hard disk space
CD-ROM drive to install from CD 
133 MHz processor or higher
32 MB of memory or higher
VGA or higher monitor resolution displayed at 800x600 pixels minimum and at least a minimum of 256
colors. 
Windows-compatible modem required for download of program if not purchased on CD
 
Technical Support
for technical support, please visit www.starbol.com
 
Back to Main Help
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50 Network Setup Information

Network Setup Information
 
To set up the Network Version of this software, you must follow these instructions.

1.) Install the Star Bill of Lading Network Edition program onto your workstation.  Along with any other
workstations that will be running the software.

2.) If you installed it to the default folder, then there will be a folder called:

C:\Documents and Settings\All Users\Documents\StarreSoft\Star Bill of Lading\data in Windows XP or
earlier 
C:\Users\Public\Documents\StarreSoft\Star Bill of Lading\data in Windows Vista or 7/8/10. 
 (This folder contains all the necessary data files to run the Bill of Lading program.)

3.) Next check to see if the program runs on all of the workstations you installed the software to.  If
everything works, then you are ready to proceed.  (Do not worry about the data yet.  This will be setup
later.)

4.) Assuming this is a new install, run the software from your Workstation.  This workstation should have
created a set of data files to be used for the system.  Click on the Help menu on the main screen, then
About...  This will display the About screen and will list the location of the data files.  

To move the data files to a shared workstation or a server, click on the link that shows the current
location of the data files - probably C:\Users\Public\Documents\StarreSoft\Star Bill of Lading\Data and
select the option to Move Current Database Folder to a New location, or of course you can Create/Open
New Database if you want to create a new one, or attach to one already created elsewhere.
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This will allow you to browse your computer or network to establish a new location for your data files to
be placed.  To select a Network location, click on the Network icon and browse to the location you
would like to place the data files.  To create a new folder, click on the Make New Folder button and key
in the name of the new folder.  When you click OK, it will move the data files to this new location and
update your system and have you close the program and re-run to access the files in the new location.  

5.) Now you need to setup your workstation(s) to point to the folder on the server that you just created
and loaded with the data files. You need to run Bill of Lading software, click the Help menu, then About..
 Click on the link as above - Create/Open New Database and browse over the location that has already
been established as containing the data files, and this will have a suffix of \data on the folder.  Be sure to
select that folder.  Click OK, and you should be all setup for access to the shared data files. 

Be sure to perform this on each of your workstation to have them all point to the server/workstation
where the data files reside, otherwise they will be using the files loaded on the workstation and the data
will not be shared. 
 
Back to Main Help
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51 Email System Setup Instructions

To set up the Star Bill of Lading System to send bills via email you must perform the following setup
first.

From the Main screen, click on the Menu - Setup, then Displayed Options/Fields.
This will display the different setup options available.
Be sure to put a check mark in the box that states - Display Email BOL Button.
Then close this screen.

From the Main screen, click on the Menu - Setup, then Email System Setup.
This will display the Email Configuration Setup screen.
You need to fill in the fields displayed on the screen with your information.  Here are the fields.

From Name: - This is your name or Company name as it will be listed in the email.
From Email Address:  This is your email address, or Company email address.
Email Reply-To Email Address:  This is the email address you want recipients to reply to if they wish to
do so.
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Email Account User Name:  This is the email account User Name.  This you should have received from
your ISP.
Account Password:  This is the password associated with your User Name assigned to you by your
ISP.
SMTP Address:  This is your SMTP server address from your ISP - such as mail.yourdomain.com.  This
is also assigned from your ISP.
Port: This is the Port to use to send emails from your ISP - such as 25.  This is also assigned from your
ISP.
Email Tracking Subject:  This field will be used as the Subject field of the email that is to be sent to the
Consignee.
Email Tracking Message Part 1:  This memo field will be used as the first part of the email message that
is to be sent to the Consignee.  You can use this field in combination with the other options to create a
customized email message to be sent.
Email Tracking Message Part 2:  This memo field will be used as the second part of the email message
that is to be sent to the Consignee.  We broke this up into two parts to allow you to further customize
the email message.  This will be included in the email message after the Customer Order Number and
Email Tracking link of the shipment if used.
Show Customer Order #: This will include the Customer Order Number on the email being sent to the
Consignee if chosen.  Now, you may have changed the actual naming of this field in the setup, such as
PO#, or something that you preferred, but it will include this value in the email message body if selected.
Show Web Tracking: If selected, this will include the Web Tracking address in the email to to be sent to
the Consignee if chosen.  This will be created using the Email Tracking Link Setup that is assigned to
the Carrier selected to make the Shipment.  If the selected Carrier does not have a web site to track the
shipment with, it will not be displayed in the email sent to the Consignee.  See the Carrier Setup screen
to see how this is generated.

After filling out this information, this will unlock the system to allow you to send the bills via email.  The
emails are sent after you click the Print button to print.  Then you can modify the System Setup Options
to display the email button.

When you want to send the bill via email, just click print for the BOL, then press the Email button.  You
will be prompted for the email address to send it to.  That is about all there is to it.

If your ISP does not allow you to send out emails directly from programs outside of email programs then
you can use the following option:

We have added another email option that will allow you to send the emails via a MAPI enabled email
client such as Outlook Express.  To use this option, setup the email system as described above, then
click on the Setup menu, then Displayed/Options Fields.  This will display the different options available
in the system.  Click on the third tab - Systems Settings.  There is an option that states - Use MAPI
email instead of BOL system default?  Just check this option and the program will call your default email
program to send email instead of this systems default one.

Then, to email a bill, just select the bill just as you would print it, click on the Print button, a screen will
display to select the print options.  There will be a Email BOL button displayed that you would click on
to activate the email feature. 
If you are using the system default, then it will ask for the email address to send it to.
If you are using the MAPI email feature, it will call your email program, attach the BOL to the email and
you would then enter the email address, just as you would any other emails.

Here is an example of an email that will be sent to the Consignee.  As you can see there are different
parts of the email that can be customized to be sent to the Consignee.
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52 Backup Data

Backup Data

 
The backup feature is accessible from the Main Screen off the File Menu.  Just select Backup/Restore
Data, then Backup/Save Data Files to Archives.  This will close the BOL program, and run the backup
program.  This program will create a zip file of all the files used in the BOL program.  You can select
where you would like the files to be backed to.
 
There is also a Restore feature that is accessible the same way.  Just select the Restore Previously
Saved Data from Archives.  This will restore the files that you previously backed up and replace what is
currently being used in the system.  

The location of the BOL database files is displayed on the screen, and there is a drop down selection for
you to specify the location you wish to place the backup .zip file.  After selection is made, just click on
the backup button to perform the copy of the database into the zip file and store it in the location
specified.

If running on the Network Edition, you cannot perform this task if someone is accessing the database.
 
Here is a list of the data files that are used in the system if you wish to backup the files yourself.
 
bold.adt
bold.adi
bolh.adt
bolh.adi
carr.adi
carr.adt
clas.adt
cons.adi
cons.adt
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ctrl.adm
ctrl.adt
delt.adi
delt.adt
desc.adi
desc.adt
dft.adt
eacc.adi
eacc.adt
lbls.adt
legl.adt
legl.adm
plac.adi
plac.adt
prgd.adt
prgh.adt
scs.adt
sicd.adi
sics.adt
sys.adt
sys2.adt
thir.adi
thir.adt
um.adi
um.adt
user.adt
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53 Purge Data

Purge Data
 

You can purge old Bills from the system at anytime, as long as there are no other users accessing the
data files.(if you are using a network edition)  
 
You can purge the data in two ways.  Permanent, or Temporarily.
 
Permanent - will remove the selected Bills forever.
 
Temporary - will save the old Bills to a purge file.  You can retrieve them back into the system at a later
date.
 
To run this option, you will need to select the menu option from the main screen, File, then Backup/
Restore Data, then Purge/Restore Old BOL's from/to System.  This will close the program and will run
an external program that will walk you through the process.  It is pretty straight forward.  But, please be
careful as if you permanently purge, you cannot get those files back, without a system restore.
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54 Import/Export Data

Import/Export Data
 
There is a feature that will allow you to Import or Export data from the BOL system.  The supported files
are as follows:
 
Carrier File Layout
Consignee File Layout
Deliver To File Layout
Description File Layout
Import File Layout
Third Party Billing File Layout

 
You can import or export to/from these files from either the Main Menu, or from the menus on each of
the respective menus on the Maintenance screens. 
 
Import from following formats:
 
Text (*.txt *.csv)
Paradox (*.db)
Dbase (*.dbf)
Excel (*.xls)
Lotus 123 (*.wk1)
Quattro Pro (*.wq1)
XML (*.xml)
MS Access (*.mdb)
 
Export to the following formats:
Paradox file (*.db)
Dbase (*.dbf)
Text file (*.txt)
HTML (*.htm)
Excel spreadsheet (*.xls)
Excel file (*xls)
Word file (*.doc)
SYLK (Symbolic Link) (*.slk)
DIF (Data Interchange Format) (*.dif)
Lotus 123 (*.wk1)
QuattroPro (*.wq1)
SQL script file (*.sql)
XML (*.xml)
MS Access database (*.mdb)
MS Windows Clipboard
Rich Text format (*.rtf)
SOSS format (*.sav)
Adobe Acrobat Document (*.pdf)
LDAP DataInterchangeFormat (*.ldif)
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55 Importing Sales Orders to create BOLs

Import Instructions and Layout for BOL Import File

There is a feature in the Star Bill of Lading program that will allow you to create an import file that will be
used to create and populate the bills in the program.  We call it the BOL Import file, which when setup
and populated, can be used to create actual bills based on a sales orders from another system.  

This may be a bit technical, for most users to accomplish, but if you have access to sales order
information from another system and can manipulate the data, it can be imported directly into the bill of
lading program files to be processed into actual bill of lading records.

First let us explain what is needed.  You will need to create an export of data from your existing sales
order information.  This would then be imported into our BOL import file.  After this is completed, the
user would create new bills by pressing a function key (F6) that will pop up a window asking for the
Sales Order number.  The user keys in the sales order number and if the data resides in the import file,
it will create a new bill based on this information.  That is all there is to it.  You will need to populate this
import file on a daily, or scheduled of your choice basis so the information stays current.

Lets start by giving you the layout of the import file that you need to send the data to.  Here is the file
layout for importing data into the BOL Import file.
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Here is an example of the type of file you need to create.  We have included some screen shots of an
excel file with some test data.
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When creating an import file to be imported into the system, the easiest way is to create an Excel
spreadsheet.  The layout would be identical to the above layout using columns for the data.  One
important statement is that each detail line that will be created in the BOL based on the import, needs to
have a separate row or record.  Also there must be a Sales Order Number assigned to each record set
in the import file.  The system reads through the records and creates the BOL based on the Sales Order
Number.  Each detail record must contain the same Sales Order number as this is the key to the file.

To run the actual import from your file to the BOL system, just run the program.  Click on the File menu,
then Import/Export, Import, BOL Import file load.  This will run the import wizard which will be used to
map the data from your file into the BOL import file.  Just follow the directions in the wizard to actually
import the data.  On the last step, always make sure you replace the data in the import file with the new
data.  Unless you are only performing updates.

In the program, you also need to turn the option on that will allow the user to create the new bills with
the data you provided.  To do this, just run the program, click on the Setup menu, then Displayed
Options fields.  Then click on the System Settings tab.  There is a check mark field that states - Allow
Sales Order file import and selection/load.  This will turn the feature on.  Then, when the user wants to
create a new bill using data from this file, the user just needs to be on the main screen and press the F6
key.  This will bring up the Sales Order Number entry screen.  Just key in an existing Sales Order
Number and the program will populate the new bill with the data provided in the import file.

Here is a picture of the Sales Order Entry screen.
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After importing the records, you can see what was loaded by clicking on the View menu option on the
screen and you will be displayed the following screen where you can select/edit and clear the data file if
you wish.

If you have any specific questions regarding this process, you can always contact our Support
department via our web site.
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56 File Layouts

Under this section you will find the layouts of the data files used in this program.  
This is useful when using the Custom Reports Add-in to know what the fields are in the specific files.

Detail File
Header File
Carrier File
Class File
Consignee File
Deliver To File
Description/Items File
Email Accounts File
Import File
Labels File
Placards File
Special Instructions File
Third Party Billing File
Unit of Measure File

56.1 Detail File Layout

File Layout for BOL Detail File
 
Here is the file layout for the Bill of Lading Detail file.
 
File Layout Definitions
System: Star Bill of Lading Software
Version: 11.xx
File name: bold.adt
Description: Bill of Lading Detail file
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56.2 Header File Layout

File Layout for BOL Header File
 
Here is the file layout for the Bill of Lading Header file.
 
File Layout Definitions
System: Star Bill of Lading Software
Version: 11.xx
File name: bolh.adt
Description: Bill of Lading Header file
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56.3 Carrier File Layout

File Layout for BOL Carrier File
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Here is the file layout for the Bill of Lading Carrier file.
 
File Layout Definitions
System: Star Bill of Lading Software
Version: 11.xx
File name: carr.adt
Description: Bill of Lading Carrier file

56.4 Class File Layout

File Layout for BOL Class File
 
Here is the file layout for the Bill of Lading Class file.
 
File Layout Definitions
System: Star Bill of Lading Software
Version: 11.xx
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File name: clas.adt
Description: Bill of Lading Class file
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56.5 Consignee File Layout

File Layout for BOL Consignee File
 
Here is the file layout for the Bill of Lading Consignee file.
 
File Layout Definitions
System: Star Bill of Lading Software
Version: 11.xx
File name: cons.adt
Description: Bill of Lading Consignee file
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56.6 Deliver To File Layout

File Layout for BOL Deliver To File
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Here is the file layout for the Bill of Lading Deliver To file.
 
File Layout Definitions
System: Star Bill of Lading Software
Version: 11.xx
File name: delt.adt
Description: Bill of Lading Deliver To file
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56.7 Description File Layout

File Layout for BOL Description File
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Here is the file layout for the Bill of Lading Description file.
 
File Layout Definitions
System: Star Bill of Lading Software
Version: 11.xx
File name: desc.adt
Description: Bill of Lading Description file
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56.8 Email Accounts File Layout

File Layout for BOL Email Accounts File



File Layouts 217

© 2020 Starre Enterprises, Inc. (starresoft.com)

 
Here is the file layout for the Bill of Lading Email Accounts file.
 
File Layout Definitions
System: Star Bill of Lading Software
Version: 11.xx
File name: eacc.adt
Description: Bill of Lading Email Accounts file
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56.9 Import File Layout

File Layout for BOL Import File
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Here is the file layout for the Bill of Lading Import file.
 
File Layout Definitions
System: Star Bill of Lading Software
Version: 11.xx
File name: impbol.adt
Description: Bill of Lading Import file
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When creating an import file to be imported into the system, the easiest way is to create an Excel
spreadsheet.  The layout would be identical to the above layout using columns for the data.  One
important statement is that each detail line that will be created in the BOL based on the import, needs to
have a separate row or record.  Also there must be a Sales Order Number assigned to each record set
in the import file.  The system reads through the records and creates the BOL based on the Sales Order
Number.  Each detail record must contain the same Sales Order number as this is the key to the file.
 
If you have any specific questions regarding this process, you can always contact our Support
department via our web site.

56.10 Labels File Layout

File Layout for BOL Labels File
 
Here is the file layout for the Bill of Lading Labels file.
 
File Layout Definitions
System: Star Bill of Lading Software
Version: 11.xx
File name: lbls.adt
Description: Bill of Lading Labels file
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56.11 Placards File Layout

File Layout for BOL Placards File
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Here is the file layout for the Bill of Lading Placards file.
 
File Layout Definitions
System: Star Bill of Lading Software
Version: 11.xx
File name: plac.adt
Description: Bill of Lading Placards file
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56.12 Special Instructions File Layout

File Layout for BOL Special Instructions File
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Here is the file layout for the Bill of Lading Special Instructions file.
 
File Layout Definitions
System: Star Bill of Lading Software
Version: 11.xx
File name: sicd.adt
Description: Bill of Lading Special Instructions file
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56.13 Third Party Billing File Layout

File Layout for BOL Third Party Billing File
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Here is the file layout for the Bill of Lading Third Party Billing file.
 
File Layout Definitions
System: Star Bill of Lading Software
Version: 11.xx
File name: thir.adt
Description: Bill of Lading Third Party Billing file
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56.14 Unit of Measure File Layout

File Layout for BOL UM File
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Here is the file layout for the Bill of Lading UM file.
 
File Layout Definitions
System: Star Bill of Lading Software
Version: 11.xx
File name: um.adt
Description: Bill of Lading UM file
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57 Registration

Registration/Purchase
 
This software requires registration.  You have 30 days to evaluate this software.  Afterwards, it will time
out and will be unusable until it is registered.  The current cost of this software is as follows:
 
$199.00 usd for Single User Edition Downloaded from Net.
$214.00 usd for Single User Edition on CD/USB which includes shipping.
 
$399.00 usd for Network Edition Downloaded from Net.
$414.00 usd for Network Edition on CD/USB which includes shipping.
 
This fee which is very low, considering the cost savings you will enjoy by not having to order BOL forms
is very reasonable.  
 
The registration process is simple.  You can follow the instructions that are prompted when you run the
program, or just go to our website and follow the instructions.  There are multiple links that will allow you
to register on-line.  If you prefer, we can bill you via invoice, and send you the registration codes via snail
mail or e-mail.  The options are up to you.  If you wish to pay by check, just click on the Buy now
option, which will take you to our web site.  You can print the Purchase Form there, fill it out, and send it
along with your payment to the address specified.
 
The licensing for this software is as follows:  Each copy of the single user version must be purchased
and registered.  
 
The Network version allows for up to 3 concurrent users to be using the software at a time.  This
software also saves and shares all data on a server or shared workstation on a network. The software
can be loaded on up to five (5) workstations that are connected on a network.  It can also be used as a
stand alone version.
 
The software registration entitles you to Technical Support and Upgrades for a period of one year from
date of purchase.  Your original purchase of the software is yours to keep indefinitely and will not require
any other purchases. You will however be billed after that initial year, annually for continued Support and
Upgrades.  The current costs for this option is $69.95 for the Single user version and $139.95 for the
Network version.  This is subject to change in the future.  This charge is optional, if you decide you do
not want upgrades or support after the initial year.  If you choose not to purchase to the Support and
Upgrades, and later decide there is an upgrade available, you will have to purchase the software at full
price.
 
To find out the current version release, go to www.starbol.com
 
All of our software is located www,starresoft.com
 
As new versions are created you will be required to register those versions to allow the updated software
to work correctly.  If you have any questions about registration processes please contact us via our Help
Desk located at help.starre.com
 

Back to Main Help

http://www.starbol.com
http://help.starre.com
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58 Custom Modifications Available

Custom Modifications Available
 
If you find something that needs to be customized to your particular needs, let us know.  We perform
modifications to the software for a nominal fee.  Just call us or contact us via our Help Desk located at 
help.starre.com.  We can quote you on a price on the modifications at no charge.  If the requested
modifications are deemed useful to other customers, we may decide to add them to a future version. 
This would allow you version to keep current on the upgrade path.  So let us know your ideas or wish
lists too.
 
 
 
Back to Main Help

http://help.starre.com
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59 EULA - End User License Agreement

EULA - End User License Agreement
 
Back to Main Help
End User License Agreement for Starre Enterprises Software

This EULA is a legal agreement between you (either an individual or a single entity) and Starre
Enterprises for the Starre Enterprises Software accompanying this EULA, which includes the
accompanying computer software, and may include associated media, printed materials and any
"online" or electronic documentation ("SOFTWARE").  By installing the SOFTWARE, you agree to
be bound by the terms of this EULA.  If you do not agree to the terms of this EULA, you may not
install or use the SOFTWARE.
SOFTWARE PRODUCT LICENSE

The SOFTWARE is protected by copyright laws and international copyright treaties, as well as
other intellectual property laws and treaties.  The SOFTWARE is licensed, not sold.
1. GRANT OF LICENSE.  This EULA grants you the following rights:
   Software.   You may install, use, access, display, run, or otherwise interact with ("RUN") one
copy of the SOFTWARE, on a single computer, workstation, terminal, hand held PC, pager, "smart
phone," or other digital electronic device ("COMPUTER").  The primary user of the COMPUTER
on which the SOFTWARE is installed may make a second copy for his or her exclusive use on a
portable computer.  
   Storage/Network Use.  You may also store or install a copy of the SOFTWARE on a storage
device, such as a network server, used only to RUN the SOFTWARE on your other
COMPUTERS over an internal network; however, you must acquire and dedicate a license for each
separate COMPUTER on which the SOFTWARE is RUN from the storage device.  A license for
the SOFTWARE may not be shared or used concurrently on different COMPUTERS.
   Reservation of Rights.  All rights not expressly granted are reserved by Starre Enterprises.  
   Accessing Services Using the SOFTWARE.  Your use of any service accessible using the
SOFTWARE is not covered by this EULA and may be governed by separate terms of use,
conditions or notices.  
2. RESTRICTIONS. 
   You must maintain all copyright notices on all copies of the SOFTWARE.
   Limitations of Reverse Engineering, Decompilation and Disassembly.  You may not reverse
engineer, decompile, or disassemble the SOFTWARE, except and only to the extent that such
activity is permitted by applicable law notwithstanding this limitation.
   Rental. You may not rent or lease or lend the SOFTWARE.  
   Software Transfer.  You may permanently transfer all of your rights under this EULA one time,
provided you retain no copies, you transfer all of the SOFTWARE (including all component parts,
the media and printed materials, any upgrades, this EULA and, if applicable, the Certificate of
Authenticity), you do not receive any payment or other compensation for transferring the
SOFTWARE and the recipient agrees to the terms of this EULA.  If the SOFTWARE portion is an
upgrade, any transfer must include all prior versions of the SOFTWARE.
   Support Services.  Starre Enterprises may provide you with support services related to the
SOFTWARE ("Support Services"), in its discretion.  Use of Support Services, if any, is governed
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by the Starre Enterprises policies and programs described in the user manual, in "online"
documentation, and/or other Starre Enterprises-provided materials.  Any supplemental software
code provided to you as a part of Support Services shall be considered part of the SOFTWARE
and subject to the terms of this EULA.  With respect to technical information you provide to Starre
Enterprises as part of the Support Services, Starre Enterprises may use such information for its
business purposes, including for product support and development.  Starre Enterprises will not utilize
such technical information in a form that personally identifies you except to the extent necessary to
provide you with support. 
   Replacement, Modification and Upgrade of the Software.  Starre Enterprises reserves the right to
replace,  modify or upgrade the SOFTWARE at any time by offering you a replacement or modified
version of the SOFTWARE or such upgrade and to charge for such replacement, modification or
upgrade.  Any such replacement or modified software code or upgrade to the SOFTWARE offered
to you by Starre Enterprises shall be considered part of the SOFTWARE and subject to the terms
of this EULA (unless this EULA is superseded by a further EULA accompanying such replacement
or modified version of or upgrade to the SOFTWARE).  In the event that Starre Enterprises offers a
replacement or modified version of or any upgrade to the SOFTWARE, (a) your continued use of
the SOFTWARE is conditioned on your acceptance of such replacement or modified version of or
upgrade to the SOFTWARE and any accompanying superseding EULA and (b) in the case of the
replacement or modified SOFTWARE, your use of all prior versions of the SOFTWARE is
terminated. 
3. TERMINATION.  Without prejudice to any other rights, Starre Enterprises may terminate this
EULA if you fail to comply with the terms and conditions of this EULA.  Starre Enterprises may
terminate this EULA by offering you a superseding EULA for the SOFTWARE or any replacement
or modified version of or upgrade to the SOFTWARE and conditioning your continued use of the
SOFTWARE or such replacement, modified or upgraded version on your acceptance of such
superseding EULA.  In addition, Starre Enterprises may terminate this EULA by notifying you that
your continued use of the SOFTWARE is prohibited.  In the event that Starre Enterprises terminates
this EULA, you must immediately stop using the SOFTWARE and destroy all copies of the
SOFTWARE and all of its component parts.
4. COPYRIGHT.  All title and copyrights in and to the SOFTWARE (including but not limited to
any images, photographs, animations, video, audio, music, text and "," incorporated into the
SOFTWARE), the accompanying printed materials, and any copies of the SOFTWARE, are
owned by Starre Enterprises or its suppliers.  All title and intellectual property rights in and to the
content which may be accessed through use of the SOFTWARE is the property of the respective
content owner and may be protected by applicable copyright or other intellectual property laws and
treaties.  This EULA grants you no rights to use such content.  If this SOFTWARE contains
documentation which is provided only in electronic form, you may print one copy of such electronic
documentation.  You may not copy the printed materials accompanying the SOFTWARE.
5. EXPORT RESTRICTIONS. You agree that you will not export or re-export the SOFTWARE,
any part thereof, or any process or service that is the direct product of the SOFTWARE (the
foregoing collectively referred to as the "Restricted Components"), to any country, person or entity
subject to U.S. export restrictions.  You specifically agree not to export or re-export any of the
Restricted Components (i) to any country to which the U.S. has embargoed or restricted the export
of goods or services, which currently include, but are not necessarily limited to Cuba, Iran, Iraq,
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Libya, North Korea, Sudan and Syria, or to any national of any such country, wherever located,
who intends to transmit or transport the Restricted Components back to such country; (ii) to any
person or entity who you know or have reason to know will utilize the Restricted Components in the
design, development or production of nuclear, chemical or biological weapons; or (iii) to any person
or entity who has been prohibited from participating in U.S. export transactions by any federal
agency of the U.S. government.  You warrant and represent that neither the U.S. Commerce
Department, Bureau of Export Administration nor any other U.S. federal agency has suspended,
revoked or denied your export privileges.
6. DISCLAIMER OF WARRANTIES.  Starre Enterprises AND ITS SUPPLIERS PROVIDE
THE SOFTWARE "AS IS" AND WITH ALL FAULTS, AND HEREBY DISCLAIM ALL
OTHER WARRANTIES AND CONDITIONS, EITHER EXPRESS, IMPLIED OR
STATUTORY, INCLUDING BUT NOT LIMITED TO ANY (IF ANY) IMPLIED
WARRANTIES OR CONDITIONS OF MERCHANTABILITY, OF FITNESS FOR A
PARTICULAR PURPOSE, OF LACK OF VIRUSES, AND OF LACK OF NEGLIGENCE
OR LACK OF WORKMANLIKE EFFORT.  ALSO, THERE IS NO WARRANTY OR
CONDITION OF TITLE, OF QUIET ENJOYMENT, OR OF NONINFRINGEMENT.  THE
ENTIRE RISK ARISING OUT OF THE USE OR PERFORMANCE OF THE SOFTWARE IS
WITH YOU. 
7. EXCLUSION OF ALL DAMAGES.  TO THE MAXIMUM EXTENT PERMITTED BY
APPLICABLE LAW, IN NO EVENT SHALL Starre Enterprises OR ITS SUPPLIERS BE
LIABLE FOR ANY CONSEQUENTIAL, INCIDENTAL, DIRECT, INDIRECT, SPECIAL,
PUNITIVE, OR OTHER DAMAGES WHATSOEVER (INCLUDING, WITHOUT
LIMITATION, DAMAGES FOR ANY INJURY TO PERSON OR PROPERTY, DAMAGES
FOR LOSS OF PROFITS, BUSINESS INTERRUPTION, LOSS OF BUSINESS
INFORMATION, FOR LOSS OF PRIVACY FOR FAILURE TO MEET ANY DUTY
INCLUDING OF GOOD FAITH OR OF REASONABLE CARE, FOR NEGLIGENCE, AND
FOR ANY PECUNIARY OR OTHER LOSS WHATSOEVER) ARISING OUT OF OR IN
ANY WAY RELATED TO THE USE OF OR INABILITY TO USE THE SOFTWARE,
WHETHER BASED ON CONTRACT, TORT, NEGLIGENCE, STRICT LIABILITY OR
OTHERWISE, EVEN IF Starre Enterprises OR ANY SUPPLIER HAS BEEN ADVISED OF
THE POSSIBILITY OF SUCH DAMAGES.  THIS EXCLUSION OF DAMAGES SHALL BE
EFFECTIVE EVEN IF ANY REMEDY FAILS OF ITS ESSENTIAL PURPOSE. 
8. LIMITATION AND RELEASE OF LIABILITY.  Starre Enterprises has included in this EULA
terms that disclaim all warranties and liability for the SOFTWARE.  To the full extent allowed by
law, YOU HEREBY RELEASE Starre Enterprises AND ITS SUPPLIERS FROM ANY AND
ALL LIABILITY ARISING FROM OR RELATED TO ALL CLAIMS CONCERNING THE
SOFTWARE OR ITS USE.  If you do not wish to accept the SOFTWARE under the terms of this
EULA, do not install the SOFTWARE.  
9. GOVERNING LAW.  If you acquired the SOFTWARE in the United States of America, the
laws of the State of North Carolina, U.S.A will apply to this contract.  If you acquired this
SOFTWARE outside of the United States of America, then local law may apply. 
 
 
Back to Main Help
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60 Future Enhancements/Upgrades

Future Enhancements/Upgrades
 
As new versions are created they will be available on our web site www.starbol.com
 
These can be fixes or new modifications to allow for a more functional system.  Most enhancements are
either from suggestions, or modifications that are purchased from our user base of companies.  If we
deem them a value to all users then we will add them to the commercial version and can be downloaded
for your use as well as long as you keep your Support and Upgrades contract current.  There is more
information about this in the Registration area.
 
 
 
Back to Main Help
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61 Copyright

Copyright
 
(C) Copyright 2020
STARRE ENTERPRISES, INC.
P.O. BOX 1075
MOCKSVILLE, NC  27028-1075
www.starresoft.com

 

 
Back to Main Help

http://www.starresoft.com


Part

LXII



Star Bill of Lading 11244

© 2020 Starre Enterprises, Inc. (starresoft.com)

62 Current Versions Available

Current Versions Available
 
There are currently Three (3) different versions of this software available.  Below is a short description of
the different versions.
 
SE - Single User Edition
This version has been designed to work on a Single workstation.  There is no data sharing features
available and can be used for any Carrier.
 
NE - Network Edition
This version has been designed to work in a Network Environment.  This can be an environment that
contains a File Server or even a Shared PC.  The data is stored in a central location be it on the Server
or Workstation and each workstation then connects to that shared data.  The restrictions for usage is
that this system will allow for up to Five (5) concurrent users accessing the data at one time.  Such as it
can be installed on 10 workstations, but only 5 of them can access the data at one time.  This version
can also run on a Single workstation with the data stored locally if needed.
 
CE - Carrier Edition
This version has been designed to work with one Carrier.  It is provided by the Carriers directly as an
added value service to their customers.  There is no charge for this version when obtained directly from
the Carriers.  Of course, there are restrictions in place that only allow you to create BOL's shipped by
this particular shipper.  If you obtain this version from your Carrier, you can always purchase the full
functioning version directly from us.  
This version has also been designed to work in a Network Environment.  This can be an environment that
contains a File Server or even a Shared PC.  The data is stored in a central location be it on the Server
or Workstation and each workstation then connects to that shared data.  The restrictions for usage is
that this system will allow for up to Five (5) concurrent users accessing the data at one time.  Such as it
can be installed on 10 workstations, but only 5 of them can access the data at one time.  This version
can also run on a Single workstation with the data stored locally if needed.
 
Each version is compatible with each other.  Meaning, if you have the SE, or CE version, you can
upgrade to either the SE or the NE.  
 
Back to Main Help
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63 Version History

Version History
 
Star Bill of Lading Software Version History
www.starbol.com/bolhistory

 
Version:
1.00 05/30/2000
Initial Compile and Development Completed
 
1.50 05/04/2001
Miscellaneous fixes.  Also, added shareware features to allow sales on Internet.  
 
1.75 06/18/2001
Added COLLECT option.  Re-Enabled the date and 
Deliver fields in the shareware version.  All functions should now be available and functional.
 
1.76 08/24/2001
Changed some of the wording in the Conditions statement.
 
2.00 10/15/2001
Reworked the whole system.  Using a new Database, along with a multitude of new features.  New User
Interface too.
 
2.10 10/21/2001
Changed the system to remove the Carrier# from the program.  Was not needed.  Also, added a 
Description file to the program.  This is used to make it easier to enter frequently used items or 
descriptions into the BOL.  Also added this function to the Detail lines as lookup fields.  Changed 
the Special Instructions field to be longer and formatted to print more legible.
 
2.11 11/05/2001
Fixed a problem with the description of articles entry.  The entry field did not stop entry at 35 characters,
which is the
size of the field in the file. 
 
2.50 1/21/2002
Major revisions.  Added new Fields, Reports, Shipping Labels, Multiple Shippers, along with other
functions.  
 
2.51 3/05/2002
Minor bug with BOL Report fixed.
 
2.52 4/10/2002
Select Shipper Menu option off the Edit Menu did not bring up Shipper Screen.
 
3.00 9/24/2002
Major release.  Added many new features that allow for more customization in the program.  Created a
new Bill of Lading form that reflects recent changes by the Department of Transportation.  Added C.O.D.
processing, Unit of Measure fields, NMFC codes, along with many more.  Extended the Description of
Articles/Line Items length to 75 characters.  Added totals for Pcs along with Weights.  Allow for different

http://www.starbol.com/bolhistory.htm
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Shipping Labels to be printed.  Multiple Page BOL's.  Added PDF creation of BOL's for emailing to
customers, carriers, etc.  User Entered BOL#'s, Can now print Blank BOL's.  Many other enhancements
included.
 
3.01 10/01/2002
Minor fixes.  Also added a second Description/Item field that can be used in the Item/Description file. 
Options to add Consignee's, Carriers, and Items during a lookup.  Added option to automatically print
Terms and Conditions report after BOL printout if you choose to do so.  Option to automatically
capitalize the Description lines or not.
 
3.10 10/10/2002
Minor fixes.  Also added a Product ID field to the Description file that can be used during a lookup
screen that is displayed while entering a line item into the BOL.  This allows for an easier lookup of
items.  Also added two more Shipping Label Forms.  Avery Label Type 5164 (6 labels per sheet) and
5165 (1 label per sheet).
 
3.11 11/14/2002
Minor fixes.  Also added a Weight Description to be printed on the BOL form.
 
4.00 3/17/2003
Major release.  Added many new fields and features.  More customization and personalization options. 
Added PRO number processing, Contacts, easier shipper selections.  Added Purge capabilities, Backup
and Restore functions.  Changes to the BOL form for easier readability.  To many small changes to list. 
Corrected minor bugs.  Re-wrote the help text, for usability.  
 
4.01 4/9/2003
Minor fixes, corrected the page numbering scheme if multiple pages are printed.
 
4.02 5/23/2003
Minor fixes, corrected the Copy/New feature.  Added InkJet Print feature to remove shaded boxes.
 
4.03 8/28/2003
Minor fix to correct printing on pre-printed forms.
 
4.04 11/04/2003
Minor fix to Copy/New feature if using System Wide BOL's.
 
5.00 12/1/2004
Major release.  Added many new features
 
5.01 12/7/2004
Minor fix to avoid disabled focus error.
 
5.02 12/12/2004
Minor fix on modifiable BOL# entry and Consignee addition to database on the fly under certain
circumstances.
 
5.03 12/13/2004
Minor fix to Copy/New procedure.  Added New Software Update Checking routine.
 
5.04 12/17/2004
Minor fix to Shipper Selection drop down.  Also fixed data conversion issue from earlier edition.
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6.00 12/5/2005
Major release.  Added many new features.
 
6.01 1/18/2006
Minor fix applied to the Bar Code Style shipping label.  Was causing print problems on Zebra printers. 
Now uses the latest drivers from Zebra.
 
6.02 1/25/2006
Minor fix applied to the pre-printed Dot-Matrix forms printing.
 
6.03 2/3/2006
Minor fix/change to remove the initial Splash screen.  
 
6.10 5/31/2006
Minor fixes/changes.  Fixed - email system calls, totaling of items weight, qty now are not dependent on
each other.
Added - extra export bol fields, margin adjustment for blank paper dot-matrix printing.
Removed the usage of oxp files, now using registry. Added two new reports - Daily Shipping Log and
Shipper Per Productivity reports.
 
6.20 7/15/2006
Minor fixes/changes.  Added a Pro number generation feature to be used to create Pro#'s for each
Carrier if defined.
 
6.30 9/18/2006
Minor fixes/changes.  Added a Freight Charge field to main screen.  This field does not print on the Bills,
but will print on the Shipping Report.  This is only used for internal purposes if you want to use it as it
can be turned on or off.
Added changes to the import sales files, now you can import a full sales order file to be loaded.  Added
new search grid to make it easier to find/lookup previous bills. Misc. fixes and small changes added.
 
6.40 10/18/2006
Minor fixes/changes.  Added new Batch printing options to allow for batch printing selections and
printing of shipping labels during the process.  Added Bold printing options to the BOL Qty's and Weight
fields and Totals on the printed BOL to make this stand out more.  Misc. fixes and small changes also
added.
 
6.45 10/27/2006
Minor changes.  Added process that will allow you to change the assignment of Shipper to an already
created bill.  Also added option to allow for printing and entry of Product Id on the Bills.  Added a lookup
code for the 3rd Party Billing file.  This makes it easier to lookup 3rd Party biller records during entry of
bills.
 
6.46 11/19/2006
Minor changes/fixes.  Adjustment to the Product ID field.  If using Product ID and not using NMFC
codes, then Product ID size increases to 20 characters.  Added option for Product ID field entry on detail
line where you can just enter the Product ID number into the detail line field and it will retrieve the
Product information and load the other fields with the default information.
 
6.47 12/01/2006
Minor changes/fixes. - Changes made for Terminal Services Customers.
 
6.50 2/21/2007
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Minor changes/fixes. - Added option to allow for 2 Qty's and 2 UM's.  Changed the screen processing to
allow for re-sizing.  Added a disconnect link between Consignees and Deliver tos.  Updates to the BOL
Export to Excel file, added more fields.  Updates to the email bol feature.  Fixed the Backup routine.
Many internal changes to processing.
 
6.60 6/15/2007
Minor changes/fixes - Added a new Shipping label for a barcode style printer - 4x3 size.  Fixed an issue
with printing a bill to PDF, caused issues.
Added a Password login feature.  You can set up 3 different levels of security, Administrator, Users, and
View only.  Misc fixes.
 
7.00 - 05/22/2009
Major release.  Added many new features and fixes.

7.05 - 06/26/2009
Minor changes/fixes.- corrected BOL Lookup/Search screen.  Was incorrectly listing/selecting past bills.
 Corrected bug with upgrades in regards to the impbol file.

7.10 - 07/09/2009
Minor changes/fixes.  Fixed an issue with the importing of orders when selecting a valid Sales Order
number, and pressing Enter.  It used to error because of the button that was used in the program.  We
have replaced all of these style buttons in the program which corrected this issue.  Also, corrected a few
more small issues that we found.

7.15 - 06/26/2009
Minor changes/fixes.- corrected BOL Lookup/Search screen.  Was incorrectly listing/selecting past bills
in reference to the selected shipper.  It was displaying all bills, not the bills for the selected shipper.

7.25 - 10/14/2009
Minor changes/fixes - Added new Mandatory Field screen under the Setup menu, Displayed/Options
fields selection.  Mandatory field selections have been added to make the user enter information into the
selected fields.  If information has not been added, then the user will not be able to print the selected bill.

7.26 - 10/16/2009
Minor changes/fixes - Added a dbl-loop selection in the system settings to handle issues with emailing
bills under the MAPI email process.

7.30 - 04/03/2010
Minor changes/fixes - corrected the font size selection of the legal notes printing of the setup section.

7.35 - 04/27/2010
Minor changes/fixes - corrected PRO# printing on the shipping labels. 

7.40 - 5/31/2010
Minor changes/fixes - Added a new selection for Canadian Shippers.  Will change the printing on the
bills to reflect Ministry of Transportation instead of DOT.  Will also change Hazardous Material reference
to Dangerous Goods. 

7.50 - 7/12/2010
Minor changes/fixes - fixed an issue with the shipping label - 5165 label - would not print the label
pieces. ie. 1 of 3... Added a Default Shipper Per field to the Users file.  If used, will automatically fill in
the Shipper Per field in the program.  Corrected some printing issues of BOL, as it was cutting off the
ends of some fields.
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7.55 - 7/22/2010
Minor changes/fixes - fixed an issue with the pro# bar code being printed and sizing.

7.56 - 8/12/2010
Minor changes/fixes - fixed an issue with the PDF,EXCEL creation of printed reports and bills.

7.60 - 8/23/2010
Minor changes/fixes - fixed a data location reset issue.

7.70 - 10/18/10
Minor changes/fixes - Corrected bugs - When printing barcodes for BOL#, and using the printed BOL#
from Customer Order, Our Order, Carrier#, etc, it was not printing the correct value in the barcode. 
When you select 3rd Party billing and enter a billing address, then later change to Collect or N/A, it now
clears out the Send Bill to address section.  Changed option for DOT Reg Number to Registered
Company for DOT requirements of HAZMAT shipping.  This prints above the Emergency Contact
information on the bill.  While printing the reports, you now have the option to select all the Shippers or
the selected shipper to print from.  Additions - Added a Filter bar to the Consignee maintenance grid so
you do not have to scroll all the way down to maintain a select shipper.  Just key in the Consignee ID or
Beginning name and it will filter out the one you are looking for.  Added PRO# to the Excel Spreadsheet
Export.  Added a switch to remove the Deliver To if Different fields from the main screen for customers
that never use them, so they do not have to tab through these fields.  Added an option for Lots on the
main screen.  This is if you do not use the NMFC codes for Hazmat, as it replaces the NMFC codes
with Lots on the screen and printed bill.

7.71 - 10/21/2010
Minor changes/fixes - Bug fixes.

7.72 - 10/25/2010
Minor changes/fixes - Bug fixes with screen layout and Lot processing.

7.75 - 12/22/2010
Minor changes/fixes - Bug fixes with BOL print option - was not printing Deliver to Contact Name.

7.76 - 12/30/2010
Minor changes/fixes - Bug fixes with Pro# barcode print, sometimes would print if not selected under
certain conditions - corrected.  5165 label printing issues with skid count printing - corrected.  Added
new options: If using Password Security option, you can now turn off the option for Users to not be able
to Change/Reset Printed BOL Status, as this would only be allowed under Admin rights in the program. 
Added option to not print the BOL# on bills, used only if using pre-printed forms that are already printed
with BOL#'s on them.  

7.77 - 2/7/2011
Minor change - When processing a Detail Line Item with a UM (Unit of Measure) of PLT (Pallet), this Qty
will not be added as a piece count total on the bill.  It will be now be ignored.  If you wish to add a pallet
to the quantity totals, a UM of SKID should be used as it will be added to the totals for pieces.  These
items will still be added to the total weights as the weight will still be accumulated.  

7.78 - 3/8/2011
Minor fix - During import process of BOL's, if there was a 3rd Party Biller, it was not properly being
added to new bills. Also corrected and issue with null UM not calculating pieces totals.

7.80 - 5/31/2011



Version History 251

© 2020 Starre Enterprises, Inc. (starresoft.com)

Minor changes - Added new default fields to the Shipper Setup screen for the following fields.  Carrier,
Route, Special Instructions, and BOL Message.  If you enter a value into these fields, they will be added
to new bills as the default entries for those fields.  Changed the Shipper selection grid to allow for sorting
of Shipper records by Name. Address1, or Shipper number.  Fixed some minor bugs in the program.

7.82 - 8/14/2011
Minor fixes - Corrected issues during upgrading with NE was causing errors when one workstation
upgraded and and older version was run inadvertently.  Corrected issues with Default Carrier information
not being loaded correctly on first bill if using default Carriers assigned to Consignees.  

7.84 - 9/29/2011
Minor changes/fixes - Added a new report to program called Shipping Report 2. You can print/preview or
create an Excel spreadsheet with this layout and information.  Changed the font embedding in the PDF
creation process.  PDF will now include all fonts used in the creation of form so it can properly be printed
and viewed on different machines that may not contain these fonts.

7.84.2 - 11/8/2011
Minor fix - Corrected printing of Contact and Deliver to Phone numbers if reverse printing option is
selected.

7.85 - 1/9/2012
Minor changes/fixes - Added a new Product Shipment report that will show you what products have been
shipped, selected by Date range, Product ID or Description along with Consignee selections.  Created
option for MOD7 check digit to be implemented and added to the PRO# creation process for selected
Carriers.

7.85.3 - 2/12/2012
Minor changes/fixes - Added an option to define using Outlook as your MAPI email program to send
emails.  If selected, it will now place a prefix of smtp: in front of the email address so that Outlook can
resolve the email address.

7.86 - 4/26/2012
Minor changes/additions - Added an option to define a customized email message to be sent to the
Consignee upon shipment of material.  This email message can contain the Tracking information to the
Carriers web site if defined, which will allow the Consignee to click on the link to display the Carriers web
site tracking information to determine deliver expectancy of the shipment.

7.86.1 - 5/20/2012
Minor changes/additions - Added a selection to either allow for PLT (Pallets) UM to be included in the
piece count totals or not.  Changed the email routine component for better control over the sending
feature.  Fixed a bug in regards to the Lot report selection screen.  Bug fixed in the Daily Shipping Log. 

7.86.2 - 6/04/2012
Minor changes/fixes - Corrected issues with Modifiable BOL's if no records existed for shipper.  When
new BOL was created for Modifiable BOL#, the system was not creating the defaults selections for the
defined shipper. Corrected BOL Re-Index program to select the default data location correctly. 

7.86.3 - 6/05/2012
Minor fix.

7.86.4 - 6/12/2012
Minor change/addition - Added a Pro# barcode selection to allow for printing of the Pro# barcode to the
shipping labels.
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7.86.5 - 6/13/2012
Minor fixes - Shipping Label adjustments corrected.

7.86.6 - 8/21/2012
Minor fixes - Corrected a XP Issue regarding window sizing error.

7.87.0 - 1/15/2013
Minor fixes/changes.  Added a Total Quantity field to the detail lines per D.O.T. requirements. 

7.87.1 - 2/18/2013
Minor fixes/changes.  Corrected a bug when upgrading from previous version and accidentally re-running
an older version from another workstation. This should only affect Network Edition.

7.87.2 - 2/20/2013
Minor fixes/changes.  Changed the BOL print to state for 3rd Party Billing selection to 'THIRD PARTY
FREIGHT CHARGES BILL TO' instead of 'Third Party Billing Information'.

8.00 - 8/01/2013
Major release.  Added many new features and fixes.  Increased the Shipper number field to 10
characters. Added options for Add-In programs to be added to system.

8.10.0 - 10/25/2013
Minor fixes/changes.  Added an option to print bills to Legal sized paper (8 1/2" x 14").  Using this option
will allow for up to 30 detail lines to be printed on each page of the bill.

8.30 - 1/9/2014
Minor changes/addition - Added a new search detail screen option.  This will allow for more options for
searching past bills.  You can now search the detail items, part numbers, classes, etc.  You can filter
out records in the new grid to narrow things down.

8.40 - 4/15/2014
Minor changes/addition - Added feature to allow for Add-in of Custom Report Designer integration into
the program. This new feature will allow for you to create and maintain your own custom reports using
the Bill of Lading data. Added a screen shot feature to the About page to the user can easily create a
screen shot and automatically send this along with system settings directly to the Support staff to help
in any diagnostic issues that may arise. Fixed a bug with the Consignee ID being keyed into the
Consignee name field and selecting the incorrect ID. Put into place other Add-in hooks for future features
and options.

8.50 - 8/15/2014
Minor fixes/changes - Changed the resizing issues with the Displayed/Options Fields screen. Created
new icons for the install to correct the look on the desktop if using larger resolution sizing. Removed the
search icon from the main screen as it was no longer useful. Changed the Custom Fields screen to
display each custom display and printed fields separately instead of grid. Removed some outdated
components that were no longer used. Fixed the User defined fields Reset option.  Updated the
Workstation Configuration Setup Utility. Misc fixes and changes.

8.60 - 10/28/2014
Minor fixes/changes - Added an option to display a charges field to the detail line items.  This option will
allow for entry of an individual charge amount per detail line item and to print the charges on the bill. 
Selecting this charge field for display will automatically remove the NMFC codes from entry along with
printing. Added an option for a default Signature name to be auto entered into the Section 7 section of
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the printed bill.  Misc fixes.

8.65 - 11/21/2014
Minor fixes/changes - Added an option when sending emails internally in the program to allow you to
select either the Consignee email address (default), or to select the Carriers email address if entered in
the Carrier record.  Fixed the Excel spreadsheet reports in the Reporting section,as they were not
properly selecting out the the records based on the selected Shipper.

8.75 - 06/19/2015
Minor fixes/changes -  If Shipper is set to default COLLECT, blank out the default bill to address when
creating a bill. Do the same if selecting a Consignee that has a default of Collect. When printing the
Terms and Conditions with the BOL, if you choose a different printer than the default for the workstation,
it will only print the BOL and not the Terms as that is sent to the default printer for that workstation. 
They both will now print to the selected printer. Changed the option on the grid search under the
Consignee maintenance to use an asterisk for the find bar instead of a % sign.  Add an option to clear
the filter bar - ESC. Added a Filter Bar option to the Search BOL's screen. On the 5165 labels - Added
the option to print the order# if the PRO number is also selected. If the Total Qty's or the Total Weight
contains a zero value, do not print the zeros. Added the following fields to be imported during import BOL
option: Tare, Net, Qty2, UM2. During the import process of bills, if there is a Customer ID number
entered in their import file and no customer name/address, then perform a lookup and load this
information from the Consignee file. Added a screen to the program to be able to view the import records
for the bill creation.  This will show the data in the impbol file off the load orders screen. Included an
option to clear the data file and also the import option as on the other screens. Fixed the issue with Bold
Qty and/or Weight line items during the print process if over 9 items on the bill. Fixed Thermal 4x3 label
as it was overrunning on the address lines. Added option to now be able to send BOL's via email using
Office365 and Gmail accounts.  Also corrected some issues with internal email processing.

8.76 - 10/17/2015
Minor fixes - Misc.small fixes and bugs.

8.80 - 12/15/2015
Minor updates - Added option to auto check and display if there are any updates available with an
appropriate link to download the latest version. Couple of bug fixes are also included in this update.

8.82 - 1/19/2016
Minor fixes/changes - Changed the heading for the Total Quantity detail line field to User 11 Detail to
allow for custom usage if needed.  Added selection for Canadian DG Consignor's Certification statement
to use the Consignor's Certification SOR/2014-152 Section 3.61 per Transportation of Dangerous Goods
Regulations. Fixed bug in Consignee Manifest Report, was not selecting correct data range.

9.00 - 12/01/2016
Major release.  Added many new features and fixes.  Changed all the screens to allow for larger viewing
of data and text. Removed ads.ini file usage and replaced with Registry option to alleviate security
issues and Virtual Store problems.  Can now create and move data folder internally. Replaced many
internal options to allow for new growth path and future enhancements. Upgraded to new Uniform Terms
and Conditions printout to reflect new NMFTA standards for Straight Bill of Lading.

9.10 - 01/23/2017
Minor updates - Added new option to automatically perform an orderly shut down of the application if it is
running and there is inactivity on the workstation for 3 hours.  This will allow the release of data files as
to help prevent possible index and data corruptions. 

9.20 - 2/23/2017
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Minor updates - Added the option to print a bar code of the Carrier number on the printed bill.  Added a
new filter row for and expansion grid option for Shippers on the Shipper Selection/Setup screen to allow
for easier selection if using many Shippers in the software. Added new import and export options to
allow for latest version of MS Excel formats.

9.30 - 4/10/2017
Minor updates - Added options to create drop down database lookups for all the custom defined fields in
the BOL like the Customer Order Number, Our Order Number, Route, Shipper Per, Dept, Carrier#,
Trailer#, and Seal#.  These fields can be custom named as before, but with an added option to create
and store a database list of these items to be used as a drop down lookup during BOL entry. These
additions can be found on the Display/Fields Settings in the Setup section of the software.

9.40 - 5/22/2017
Minor updates - Added new User option of Limited access to allow the User to create BOL's, but not
have access to the file maintenance screens to limit access to changing or deleting records from the
system data files.  Expanded the Shipper drop down selection field on the main screen to be able to re-
size and show Shipper name and Address1 for users that have multiple shippers with the same name,
but different addresses to make the selection process easier.

9.41 - 5/31/2017
Minor fixes - Corrected a bug in the Shipper selection drop down on the main screen.  Was sometimes
selecting the incorrect shipper during first run.  Also, added the Shipper Number field to the same drop
down field grid for selection.

9.45 - 8/21/2017
Minor updates/fixes. - Corrected a bug when using Modifiable BOL# as the User definition for Shipper
Per was not loading properly. Added an feature in the Network Edition that on first run the record
displayed will automatically be locked/disabled. If user would like to edit this record, they must click on
the Edit button that is displayed, or the Edit menu, Edit BOL Record option.  This only displays if
System Option - Disable Printed BOL lock is checked, or if the displayed Bill has not been printed.

9.46 - 10/31/2017
Minor updates - Changed the MOD7 Pro# check digit processing for the Pro# creation process to allow a
10th digit to be used in the Pro# assignment scheme. 

9.50 - 11/13/2017
Minor Updates - Added the Check Digit PRO# processing for YRC.  Modified the pro number field sizes
to make them larger in the Carrier file. If using the PRO# creation process in the Carrier file, and you
have the PRO# selected in the Mandatory fields, it would stop you from printing.  This has been
corrected.

9.52 - 3/30/2018
Minor Updates - Added a new routine to the new BOL procedure to process a database refresh on the
Ctrl file and System file.  Removed the update routine from the Network Edition. This will now only inform
use of an available update, but they will have to download and install on each workstation with
instructions so that all workstations are updated at one time to help stop issues when performing an
update.

9.53 - 5/01/2018
Minor Update - Corrected a bug when printing 5163 labels. System was not saving the printer selection
information correctly. 

9.54 - 6/22/2018
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Minor Update - Changed the Workstation Configuration Setup Utility to allow for manual entry of UNC
path incase they cannot browse directly to another computer for stored database location. Fixed bug on
the Print 2 PDF button as it was moving on the screen if certain settings were turned on.  Added a BOL#
Heading Prefix to print in front of the BOL# heading on the printed bill if needed. Updated the Backup/
Restore procedure to create an enhanced backup of database. Created a new application to clear out
the saved program settings to reset back to the default display settings. 

9.55 - 9/15/2018
Minor Update - Changed routine during startup to allow you to not create a new set of database files or
clear out selection if the already selected location is not valid.  This has been done in case a network
location is not valid for a period of time due to network issues.  Will allow you to just shut down and try
again later.

10.00 - 3/07/2019
Major release.  Added many new features and fixes.  Added a user defined detail field database lookup
for original Total Qty field.  Added batch printing of 4x3 labels if being used during batch BOL printing. 
Created new Backup application. Added options to db for upcoming features.

10.10 - 04/12/2019
Minor Update - Changed the location of the Import and Export specifications to store in the database
location folder.  Corrected the import BOL process to include the correct associated fields in the Carrier
database.  Fixed the BOL# bar code and Pro# bar code selection, cannot have both selected. Misc.
fixes/bugs.

10.20 - 05/20/2019
Minor Update - Added a Unit Weight to the main screen entry if option is turned on.  This will be used to
calculate the line item Weight field.  Qty*Unit Weight = Weight.  Weight field can still be overwritten
manually if needed.  Changed the layouts of BOL Detail and Import tables.

10.30 - 06/28/2019
Minor Update - Fixed a couple of bugs along with the printed BOL layout as there was a box out of
alignment.

10.35 - 07/11/2019
Minor Update - Added an error check process for compatibility of application version against database
version during initial startup.

10.40 - 10/04/2019
Minor Update - Added a system option to print the Standard Anti-Diversion Clause on the printed bill. 
This is for U.S. Only Exporting options and will only be used and processed using the Laser printer
option.  Does not function with the pre-printed forms.

11.00 - 5/15/2020
Major release. Added all new database lookup screens because the old ones were too small and not
resizable.Added a new Workstation Configuration Setup Utility for better browsing of database locations.
Added Consignee and Deliver to heading labels to the labels file to be able to customize on the screen
and printed BOL if you choose. Added a new system control file for internal usage. Created an option to
print Return BOL's - this is a check mark on the main screen, and if checked will reverse print the
Consignee and Shipper field information on the printed BOL. Replaced all the menus with resizable
menus to match the resizing of the screens. Replaced old Backup and Restore application with a new
one.

11.01 - 05/27/2020
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Minor Update - Corrected Upper Case entries to field entries. Corrected tab order on field settings
screen.

11.10 - 07/21/2020
Minor Update - Changed/fixed the database lookup filtering bar fields to properly filter the selections
during a lookup.

11.20 - 08/31/2020
Minor Update - Added a new option to the system options to be able to turn off the printing of the order
numbers on the shipping labels.  Updated the system utility for index rebuilding.

11.30 - 09/17/2020
Minor Update - Fixed an issue with the Deliver to selections. If bill is already created, and select Deliver
to, it did not associate with the displayed Consignee when dropping down for selection. Also, the same
when selecting Deliver to maintenance. This was only an issue when linked Consignee and Deliver to is
used and editing an existing BOL. New - On the reports selection screen, now saving the selected
printers used to print the reports for recall next time printing instead of using the default printer on
workstation. Fixed issues with new searches for Carriers using the Carrier Edition.  

11.40 - 11/17/2020
Minor Update - Fixed an issue with the Product ID lookup (F2) was defaulting to Description field lookup.
Also fixed option if only want to use Product ID for lookup, it will now lookup using Product ID if you are
using any of the grid fields, based on system selection to do so.  Added a backup prompt on exit option,
along with an auto backup option for the Single User Editions.  Added Outlook email send to setup, as
based on Outlook 365 and Outlook 64 bit application. Windows has started not allowing direct MAPI
connections to these products, so added a new connection and send option. It will send directly to
Outlook Outbox, then will send during your selected Outlook settings.
 

-------------------------------------------------------------------------------------------------------------------
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